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Livescribe Inc. 

Anoto is a trademark of Anoto Group AB. All other brand and product names are trademarks of their 
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Copyright © 2007-2010 Livescribe Inc. All rights reserved.

IMPORTANT: Please read the End User License Agreement with this product before using the 
accompanying software program(s). You accept the terms of the End User License 
Agreement by using any part of the software. Using any non-authorized charging 
accessories or ink cartridges may damage the Livescribe™ smartpen and voids the 
Livescribe smartpen warranty (see Warranty Information on page 115.)

Software Downloads Available

To download Livescribe Desktop software, go to www.livescribe.com/install.

Agency Compliance Information

For product, regulatory, and compliance information, see Regulatory Information on page 111.
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About This Guide
About This Guide

This guide contains detailed descriptions of the Livescribe™ smartpen and applications that run on it. 
Use this guide along with the Getting Started Guide included with the Livescribe smartpen. For 
information about desktop software that works with the Livescribe smartpen, see the Livescribe™ 
Desktop User Guide.

NOTE: This guide instructs you to tap on paper controls to perform certain functions. When you see this 
instruction, turn on your smartpen, and use the ink tip to tap on the printed buttons within the 
Getting Started Guide and Livescribe™ Dot Paper notebooks. 
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1 Introducing the Livescribe™ 
Smartpen
Congratulations on the purchase of your new Livescribe™ smartpen. This topic introduces you to the 
Livescribe™ smartpen. To set up and begin using your smartpen, see Getting to Know Your 
Livescribe™ Smartpen on page 16. To learn about what is new in this release, see New in this Version 
on page 4. 

Livescribe Smartpen

Livescribe is fundamentally changing the way people capture, access and share information with pen 
and paper. Livescribe has developed a breakthrough low-cost mobile computing platform, which 
includes the award-winning Livescribe smartpen, dot paper, smartpen applications, Livescribe Desktop 
software, Livescribe Online Community, and development tools.

The Livescribe™ smartpen is an advanced paper-based computer in the form of a pen that records 
everything you hear and write. It synchronizes the audio your hear to what you write, so you never 
miss a word. Just tap on your notes and the smartpen will play back what you recorded from that exact 
moment in time. 
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Livescribe™ Dot Paper
The smartpen provides both audio and visual feedback, powerful processing capabilities, and 
substantial built-in storage. The smartpen integrates several components and technologies. It also 
uses firmware and application software to support the interaction of all of its components and to enable 
built-in handwriting recognition, and applications such as Paper Replay™, among many others.

When you power on your Livescribe smartpen and begin writing on Livescribe™ dot paper, the 
smartpen captures and stores the notes you write. To capture your writing, the smartpen uses its built-
in infrared camera to take digital snapshots of a special dot pattern on the paper as the tip moves over 
the paper while you write. See Livescribe™ Dot Paper on page 2 for information about the dot pattern. 

When recording audio in a Paper Replay™ session, the smartpen links the recorded audio to your 
notes based on the dot pattern on the page. With this information, the smartpen can play back the 
audio that was recorded at the exact time you were writing your notes. Specifically, when you tap on 
your notes with the smartpen, it locates the position where you are tapping and starts to play back the 
audio at the position linked to that paper location.

Livescribe™ Dot Paper

To perform its many operations, your Livescribe smartpen requires Livescribe™ dot paper. This paper 
is standard paper with printed microdots on its surface. These dots are nearly invisible to the human 
eye. However, the smartpen can easily see these dots and uses them to know which page you are 
writing on and the exact location on that page. The smartpen can even see these dots through the ink 
you write on your pages. 

The microdot pattern on each page is based on technology from Anoto AB. This dot pattern consists of 
small dots (100 micrometers in diameter) arranged with a spacing of approximately 0.3 mm. The dot 
pattern overlays an imaginary square grid. The dots are slightly displaced from the grid, with each dot 
in one of four possible positions, forming the proprietary Anoto dot pattern.  

 

The dot pattern identifies the specific page and locations on the page of the notes you write. Your 
Livescribe smartpen uses the dot pattern in a way similar to a geographical positioning system (GPS). 
But, instead of identifying locations on land, it finds locations on paper and stores your writing as digital 
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Livescribe™ Dot Paper
ink using those locations. Using this patented dot-positioning system (DPS), the smartpen precisely 
tracks its own movement on paper. As a result, anything you write – words, numbers or drawings – can 
be stored, recognized, and intelligently responded to by the smartpen.

The area of the entire Anoto dot pattern is huge, and represents a piece of paper the combined size of 
Europe and Asia. Livescribe™ dot paper is based on a portion of this dot pattern. 
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2 New in this Version
In this version, Livescribe added new features and made improvements to correct known issues, 
improve usability, and optimize performance. For detailed information about this release, read the 
Release Notes located here:  www.livescribe.com/releasenotes.

New Features

The following new features have been added in this version.

Support for Livescribe Paper Tablet
The Livescribe Paper Tablet enables your Echo smartpen to work as an input device on your com-
puter. The Paper Tablet is similar to a graphics tablet. You connect your smartpen to your computer 
using its micro-USB cable and use it like a stylus. You then use one or more pages from a Livescribe™ 
dot paper product as the tablet. The Paper Tablet is available for purchase from the Livescribe Store 
and from Livescribe retailers as a redeemable application card. To learn how to use the Paper Tablet, 
download the Livescribe Paper Tablet User Guide from the Livescribe Store. 

Livescribe Sticky Notes

Livescribe Sticky Notes take the familiarity and convenience of sticky notes—small pieces of paper 
with a strip of repositionable adhesive on the back—and add the power of Livescribe dots.

You can quickly capture short notes, lists, and reminders while adding audio to them. Attach Livescribe 
Sticky Notes to any printout, magazine, or book page to add personalized interactive notes. As with 
other Livescribe dot paper products, transfer your Sticky Notes to your desktop computer to organize, 
search, or share them with others.
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New Features
Sticky Notes pads come in two sizes. The 3”x3” Livescribe Sticky Note looks like this: 

The 3” x 5” Livescribe Sticky Note looks like this: 
Livescribe™ Smartpen User Guide 5



New Features
Packs and Pads

Each pad of Livescribe Sticky Notes contains 75 sheets. Pads are sold in packs of six: three pads of 
3”x3” and three pads of 3”x5”. 

Use only one Livescribe pack at a time. You should proceed as follows:

1. Use up all the pads in one pack.

2. Archive the pads.

3. Open a new pack.

Your smartpen can carry up to 6 pads (Sticky Notes 3”x3” Pads 1, 2, 3 and Sticky Notes 3”x5” Pads 
1, 2, 3) at the same time. When you are done with all six pads, archive them with Livescribe Desktop 
before starting a new 6-pack. Please do not use identical pads from different 6-packs at the same time, 
because your smartpen will recognize them as the same pad.

To learn about archiving, see Archiving Paper Products on page 110.

New Buttons

Livescribe Sticky Notes come with the familiar Nav Plus and Paper Replay buttons printed along the 
bottom edge. Along the top edge, Sticky Notes have buttons that are new to the Livescribe paper 
product line. 

The Home Button stops the current smartpen application and returns you to the default display (which 
shows the current time). 
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New Features
The three Shortcut Buttons have functionality that you assign to them. 

To learn more, see Home Button on page 7 and Shortcut Buttons on page 10.

Home Button
Tapping on the Home Button stops the currently running smartpen application and returns the smart-
pen to its default mode: The current time is showing on the display and the smartpen is ready to store 
whatever you write on Open Paper.

Home Button in New and Old Livescribe Notebooks

On Livescribe Sticky Notes and newer Livescribe notebooks and journals, the Home Button is repre-
sented by the icon of a house. For an illustration of the house icon, see New Buttons on page 6.

Although new in this version, the Home Button functionality is available on older Livescribe notebooks 
as well. Instead of a house, however, look for a faintly printed circle to the right of the pre-printed Nav 
Plus in the corner of each page. The black arrow in the following illustration points to the circle that acts 
as the Home Button.
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New Features
Double-Tap Can Be Set by You

Besides single-tapping on the Home Button, you can also double-tap on it. By default, both actions do 
the same thing. However, you can assign different functionality to double-tapping the Home Button. 
You can assign any Open Paper smartpen application or Quick Command. For instance, if you do lots 
of calculations, you might want to go to Calc Quick Command when you double-tap on the Home But-
ton. 

To set the Home Button to launch an Open Paper smartpen application or perform a Quick 
Command:

1. Double-tap the center of the Nav Plus. A double-tap 
is two taps in quick succession.

  

2. Main Menu will be displayed on the Livescribe 
smartpen.

  

3. Tap down on the directional arrow of the Nav Plus to 
scroll through a list of applications on the Livescribe 
smartpen.
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New Features
4. When Shortcuts is displayed, tap right to select it. 

  

5. The display will scroll: Assign Home Button 
double-tap. Tap right.

 

6. The display will scroll: Write a command, then 
double-tap. You can write an application name or 
a Quick Command.

 

7. Write any Open Paper smartpen application name 
or write a Quick Command. For instance, write calc

NOTE: Do not double-tap the center of the Nav Plus or 
write a doubled-back horizontal line. Write only 
the letters that make up the Quick Command.
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New Features
Shortcut Buttons

Shortcut Buttons appear on some of the newer Livescribe™ dot paper products, such as Livescribe 
Sticky Notes. They are labeled with successive numbers: 1, 2, 3, etc. 

You can assign functionality to the Shortcut Buttons, just as you can assign functionality to double-
tapping the Home Button. Assign any Open paper smartpen application or Quick Command to a 
Shortcut Button.

To set Shortcut Button 1 follow these steps. We will set Shortcut Button 1 to the Calc Quick 
Command:. 

8. The display will briefly display the smartpen 
application name or Quick Command. Then it will 
confirm the new assignment.
For instance, it will briefly show the Calc Quick 
Command. Then it will start scrolling:  
Home Button is Now Assigned To [calc] 

  

1. Double-tap the center of the Nav Plus. A double-tap 
is two taps in quick succession.
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New Features
2. Main Menu will be displayed on the Livescribe 
smartpen.

  

3. Tap down on the directional arrow of the Nav Plus to 
scroll through a list of applications on the Livescribe 
smartpen.

4. When Shortcuts is displayed, tap right to select it. 

  

5. The display will scroll: 
Assign Home Button double-tap.  
Tap down to display Assign Shortcut 1.  
(Tap down again to display Assign Shortcut 2, etc.)  
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New Features
6. When you see the number of the shortcut you wish 
to set, tap right. 

  

 

7. The display will scroll: Write a command, then 
double-tap. You can write an application name or 
a Quick Command.

 

8. Write any Open Paper smartpen application name 
or write a Quick Command. For instance, write calc

NOTE: Do not double-tap the center of the Nav Plus or 
write a doubled-back horizontal line. Write only 
the letters that make up the Quick Command.
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New Features
Tapping on an Unassigned Shortcut Button

Unlike the Home Button, the Shortcut Buttons have no default assignments. If you tap on an 
unassigned Shortcut Button, the following message displays on the smartpen: To assign this 
shortcut, tap and hold the button, then write the name of an application or Quick Command.

To set an unassigned Shortcut Button by tapping directly on it, follow these steps. We will set 
Shortcut Button 1 to the Calc Quick Command.

9. The display will briefly show the smartpen 
application name or Quick Command. Then it will 
confirm the new assignment.
For instance, it will briefly show the Calc Quick 
Command. Then it will start scrolling:  
Shortcut Button 1 is Now Assigned To [calc]    

1. Tap and hold the Shortcut Button you want to set 
for three seconds—for instance, tap and hold 
Shortcut Button 1. 
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New Features
If you accidentally tap on an unassigned Shortcut Button and you do not wish to set it at this time, tap 
on any Open Paper.

2. The display will scroll: Write a command, then 
double-tap. You can write an application name or 
a Quick Command.

 

3. Write any Open Paper smartpen application name 
or write a Quick Command. For instance, write calc

NOTE: Do not double-tap the center of the Nav Plus or 
write a doubled-back horizontal line. Write only 
the letters that make up the Quick Command.

 

4. The display will briefly show the smartpen 
application name or Quick Command. Then it will 
confirm the new assignment.
For instance, it will briefly show the Calc Quick 
Command. Then it will start scrolling:  
Shortcut Button 1 is Now Assigned To [calc]    
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Improvements and Corrected Issues
Improvements and Corrected Issues

Smartpen performance has been optimized is several ways. Also, several existing features of the 
smartpen software have been refined to increase intuitiveness and flexibility.

Performance Improvement
• Faster booting: When powering on, the smartpen loads its software more quickly and is ready to 

use in less time. 
• Faster transfer speed: Data transfer to and from the smartpen occurs at a faster rate.

• Faster file access in Echo: The Echo smartpen reads data from and writes data to its file system 
more efficiently, improving responsiveness in the loading and operation of smartpen applications.

Left-Tap: Exit the Way You Came In

Left-tap is the way to the exit on the smartpen. You can tap left on the directional error of a Nav Plus to 
exit a smartpen application or a Quick Command. You can also exit by left-tapping around any Launch 
Lines you drew. See Launch Line and Tap Around on page 67.

In this version of the smartpen software, the results of left-tapping in any situation were standardized to 
be intuitive and helpful. If you are curious, the rule is: You exit the way you came in. This means that 
left-tapping leads you back toward your starting place: 

• If you started by tapping Nav Plus and navigating the Main Menu, then left-tap leads you back to 
the Main Menu.

• If you started by drawing a Launch Line or Quick Command on Open Paper, then we assume you 
do not care about the Main Menu right now: the current time is displayed instead. 

• In either case, you end up in the same state: no application is running and the smartpen is ready to 
store the next thing you write on Open Paper.

NOTE: Left-tapping from the submenu of a smartpen application or Quick Command backtracks up the 
menu hierarchy toward the root level. Left-tapping from the root level jumps to Main Menu or the 
current time display, as described above.

NOTE: The root level of a launched application is the initial menu displayed when you launch the 
application. The root level of a running Quick Command is the list displayed when you execute 
the Quick Command. In the case of Paper Replay when launched explicitly, the root level is the 
initial menu containing items such as Record New Session, Play Session, etc. The root level of 
the play Quick Command is the”Play Session” list of Paper Replay.
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3 Getting to Know Your Livescribe™ 
Smartpen
This topic introduces you to the features of your Livescribe smartpen and provides step-by-step 
instructions for setting it up and using it to capture your handwritten notes and recorded audio.

What is in the Box?

• Livescribe™ smartpen

• Starter Livescribe Dot paper notebook

• Interactive Getting Started Guide

• Ink cartridges

• Micro-USB cable (Echo™ smartpen only)

• Smartpen cap (Echo™ smartpen only)

• 3-D Recording Headset (Pulse™ smartpen only)

• USB mobile charging cradle (Pulse™ smartpen only)

• Protective soft case (Pulse™ smartpen only)

Other things get:

• A Warranty (See Warranty Information on page 115)

• Free downloads of Livescribe™ Desktop for Windows and Mac OS X.

• Free sign-up for a Livescribe Online account with 500 MB of online space to store and share your 
smartpen content.
Livescribe™ Smartpen User Guide 16



Identifying Your Livescribe™ Smartpen Model
Identifying Your Livescribe™ Smartpen Model

There are two Livescribe smartpen models: the Echo™ smartpen and the Pulse™ smartpen. Use the 
table below to identify your model. 

Smartpen Model Color Power Symbol

Echo™ smartpen Black
Power button has a printed power symbol .

Pulse™ smartpen Titanium and Black Pro Pack 
(Special Edition) Power button has printed power symbol .

Pulse™ smartpen Charcoal-Blue Power button does not have a printed power symbol.
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Anatomy of a Smartpen
Anatomy of a Smartpen

If you own an Echo™ smartpen, use the diagram below to learn about its components. 

• Micro-USB connector

• Headset/Audio jack

• Organic Light-Emitting Diode (OLED) 
display

• Built-in microphone 

• Built-in speaker 

• Anti-roll design

• Soft rubber grip

• Replaceable ink tip

• Echo smartpen cap
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Anatomy of a Smartpen
Use the diagram below to learn about thePulse™ smartpen components. 

1. Power button

2. Headset/Audio jack 

3. Built-in microphone 

4. Organic Light-Emitting Diode (OLED) display

5. Built-in speaker 

6. USB connector

7. Infrared camera

8. Replaceable ink tip

9. Rechargeable lithium battery (non-removable)

10.Pulse smartpen cap (purchased separately)
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Turning On Your Smartpen
Turning On Your Smartpen

To use your smartpen, first turn it on. It must be running to capture written notes or enable its audio 
recording or playback features. See Using the Paper Replay™ Application on page 69 for more 
information.

1. Press the Power button to turn on your 
smartpen. As the smartpen starts up, the display 
shows the words Livescribe and then 
Starting... After start-up completes, the display 
shows the time. 

 

2. The first time you use the smartpen, you must 
set it to the current time and date. See Setting 
the Date on page 31 and Setting the Time on 
page 32 for more information.

3. When you are finished using your smartpen, 
press the Power button again to turn it off.

Writing and Recording Audio

There are many features of your Livescribe smartpen. One of its primary uses is to capture notes and 
optionally record audio. 

Capturing Notes without Audio

To use your Livescribe smartpen to capture notes without audio, follow these steps.

1. Power on your Livescribe smartpen by pressing the power button.

2. If needed, remove the smartpen cap. If you are using a new ink cartridge, you may need to remove 
possibly the small protective plastic coating from your ink cartridge tip. All new ink cartridges have 
this coating to prevent the ink from drying up.

NOTE: If you have given your smartpen a name 
using Livescribe Desktop, your smartpen will 
display its name when you power it on.
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Writing and Recording Audio
3. Begin writing on any Livescribe™ dot paper product, such as a Livescribe notebook, journal, or flip 
notepad. As long as the smartpen is on, it will capture your handwritten notes and drawings. 

Capturing Notes with Audio

To use your Livescribe smartpen to capture notes and audio recordings follow these steps. For details 
about Paper Replay™, see Using the Paper Replay™ Application on page 69.

1. Power on your Livescribe smartpen by pressing the power button.

2. If needed, remove the smartpen cap. If you are using a new ink cartridge, you may need to remove 
possibly the small protective plastic coating from your ink cartridge tip. All new ink cartridges have 
this coating to prevent the ink from drying up.

3. Start the Paper Replay™ application to record audio as you write. 

To start Paper Replay, tap on the Record button  in any Livescribe™ dot paper product, such 
as a Livescribe notebook, journal, or flip notepad. See.Starting Recording with a Pre-Printed 
Record button on page 70
You can also launch the Paper Replay™ application directly from the Nav Plus. See Using the Nav 
Plus on page 46 for more information. 

4. Begin writing on any Livescribe™ dot paper product. As long as the smartpen is on, it will capture 
any handwritten notes and drawings. 

5. When you have finished taking notes and recording audio, tap on the Stop button  in any 
notebook. Or, stop the Paper Replay™ application with the Nav Plus. 

NOTE: The Stop button ends the Paper Replay audio recording. If you are taking notes without recording 
Paper Replay audio, you do not need to use the Stop button. 

6. Listen back to your recorded audio by tapping on your handwritten notes. 

Recording Audio Only

You can use your smartpen to record audio only, without capturing notes. See Recording Paperless 
(Audio Only) Sessions on page 79 for more information about this capability.

1. Power on your Livescribe smartpen by pressing the power button.

2. Start the Paper Replay™ application to record audio. To start Paper Replay audio recording, use 
one of the following methods:
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Writing and Recording Audio
• Use the Quick Record feature (see Starting Recording Using Quick Record on page 70). Press 
and hold the Power button for approximately five seconds until the display indicates that the 
recording started. 

 

• Tap on the Record button  in any Livescribe™ dot paper product, such as a Livescribe 
notebook, journal, or flip notepad. See.Starting Recording with a Pre-Printed Record button on 
page 70

• Launch the Paper Replay™ application directly from the Nav Plus. See Using the Nav Plus on 
page 46 for more information. 

3. When you have finished recording audio, tap on the Stop button  in any notebook. Or, stop the 
Paper Replay™ application with the Nav Plus. 
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Charging an Echo™ Smartpen
Charging an Echo™ Smartpen

The USB connector for an Echo™ smartpen is located on the top next to the headset jack. This is a 
standard micro USB connector that is compatible with any standard USB charging cable. Follow these 
steps to charge your smartpen 

1. Before charging your Echo™ smartpen, 
download and install the Livescribe 
Desktop software from http://
www.livescribe.com/install.

 

2. Plug your Micro-USB cable into the USB 
port on your computer and plug the other 
end of the cable into your smartpen.

NOTE: You can also charge the Echo 
smartpen directly from an electrical 
outlet with the Universal USB AC Wall 
Adapter.
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Charging a Pulse™ Smartpen
Charging a Pulse™ Smartpen

The USB connector for a Pulse smartpen is located on its side. The connector is designed to fit into a 
compatible Livescribe USB charging cradle. Follow these steps to charge your smartpen 

A battery and lightning bolt symbol will 
be displayed on your Livescribe smart-
pen when it is charging. 
A full charge can take up to 2.5 hours. To 
determine if your Livescribe smartpen is 
fully charged, see Viewing the Battery 
Level on page 36.

 

TIP: The plug and blinking battery indicator 
means your Livescribe smartpen needs 
to be charged.

 

1. Before charging your Pulse™ smartpen, 
download and install the Livescribe Desktop 
software from www.livescribe.com/install.

 

2. Plug your USB mobile charging cradle into the 
USB port on your computer. The smartpen will 
charge directly from your computer’s USB port 
when the computer is on. The USB connection 
(located on the side of the Pulse smartpen) is 
designed to dock into the compatible Livescribe 
USB mobile charging cradle. 

NOTE: You can also charge the Pulse smartpen 
directly from an electrical outlet with the Pro 
Charging Cradle or the Universal USB AC 
Wall Adapter.
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Replacing the Ink Cartridge or Stylus
Replacing the Ink Cartridge or Stylus

To replace an ink cartridge, just use your fingers to grasp and pull out the old cartridge and insert a 
new one. If you own a Pulse smartpen and have a USB mobile charging cradle, you can instead use 
the cradle to help replace the cartridge as follows.

3. Place the Pulse smartpen in your USB mobile 
charging cradle. 
A battery and lightning bolt symbol will be dis-
played on your Livescribe smartpen when it is 
charging. 
A full charge can take up to 2.5 hours. To deter-
mine if your Pulse™ smartpen is fully charged, 
see Viewing the Battery Level on page 36.

 

TIP: The plug and blinking battery indicator means 
your Pulse™ smartpen needs to be charged.

 

1. Insert the smartpen ink tip into the ink cartridge removal ring.

2. Tilt the smartpen so that it firmly rests against the removal ring and lift the smartpen away from the 
ring.  

3. Lifting the smartpen away from the cradle will safely separate the ink cartridge from the magnet 
inside the smartpen that holds it in place.
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Using a 3-D Recording Headset
NOTE: If you want to use the smartpen but do not want to make ink marks on your paper, purchase a 
stylus from the Livescribe web store. To insert the stylus, follow the steps above, but substitute 
the stylus for the replacement ink cartridge. 

Using a 3-D Recording Headset 

With your Livescribe smartpen, you can record audio with either the built-in microphone or a 3-D 
Recording Headset. Livescribe designed the built-in microphone for monaural recordings in smaller 
recording environments, such as a conference room. When recording in larger spaces, we recommend 
using a 3-D Recording Headset, which contains a microphone in each earbud. The dual microphones 
enable binaural recordings, which accurately recreate the spatial audio environment.

1. Left and right speakers

2. Left and right microphones

Binaural recording is a special type of stereo recording that uses two microphones, one placed in each 
ear. This type of recording provides the most accurate spatial sound quality because the microphones 

4. Place your new ink cartridge in the smartpen. Before using the smartpen, be sure to remove the 
protective plastic coating from your ink cartridge tip. All new ink cartridges have this coating in 
place to prevent the ink from drying up.
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Renaming Your Smartpen in Livescribe™ Desktop
effectively mimic your ears - when you play a binaural recording back, it sounds like you are actually in 
the location where you recorded. 

Once you record audio, you can play back the binaural effect using stereo earphones. You can also 
play back the binaural effect as a regular stereo recording over any type of headphones or speakers.

The 3-D Recording Headset included with each Pulse smartpen has a custom jack. This is required for 
binaural recordings. However, if you want to use a 3.5mm stereo headset just for playback, connect 
your 3.5mm headset to your smartpen using a standard 2.5mm to 3.5mm adaptor.

If you own an Echo™ smartpen, you can use any standard 3.5mm stereo headset for playback. For 
binaural recording, you need to use a Livescribe 3.5mm 3-D Recording Premium Headset. You can 
purchase this separately from the Livescribe Online Store. 

NOTE: You can record binaural audio with the earbuds in your ears or around your neck as shown below. 
Make sure the “L” earbud is in your left ear and the “R” earbud is in your right ear. 

 

NOTE: Keep the earbuds about 6-8 inches apart to mimic the position of your ears.

Renaming Your Smartpen in Livescribe™ Desktop

Your smartpen has a default name. You can rename your Livescribe smartpen to identify it from other 
smartpens in Livescribe™ Desktop. 

To rename your smartpen:

1. Install and Launch Livescribe™ Desktop. (See the Livescribe™ Desktop User Guide for details).

2. Dock the smartpen to be renamed.

3. If it is not already selected, use the smartpen selector drop down to choose the smartpen you want 
to rename.

4. Choose Tools > Smartpen > Rename. At the prompt, type the smartpen name and click OK.
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Rebooting Your Livescribe™ Smartpen
Rebooting Your Livescribe™ Smartpen

If for some reason your Livescribe smartpen is unresponsive, perform the following steps:

1. Charge your smartpen using its cradle (for Pulse™ smartpens) or Micro-USB cable (for Echo™ 
smartpens) for at least five minutes. If your smartpen is still nonresponsive after five minutes of 
charging, you may need to reboot it.

2. To reboot your Livescribe smartpen, press and hold the power button for 10 seconds.
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4 Configuring Your Livescribe™ 
Smartpen
You can configure the Livescribe smartpen to your own preferences. There are generally two ways to 
view current smartpen settings and optionally change them:

• Use printed buttons in the Status and Settings areas printed on the inside covers of Livescribe 
notebooks. Using a Notebook’s Settings and Status Buttons on page 30

• Use the Settings menu on your smartpen. Using the Settings Menu on page 38

NOTE: You can also view and manage your smartpen content using Livescribe Desktop. For details, see 
the Livescribe Desktop User Guide.

From your smartpen, you can view and change the following settings:

Setting Category Setting Values

Display Settings Display brightness 100%, 90%, 75%, 50%, 10% 

Display orientation right-handed, left-handed

Auto-off time 30 minutes, 1 hour (default), 2 hours, 4 hours

Scroll speed 1-10 (1 is slowest, 10 is fastest)

Audio Settings Menu voice On, Off

Playback latency On, Off

Audio (Recording) quality High, Medium, Low

Microphone sensitivity Conference room, Lecture hall, Automatic

Date and Time Settings Set the date and time

Date format mm.dd.yy, dd.mm.yy, yy.mm.dd

Time format 12-hour, 24-hour

 Locale Switch default locale of 
displayed text and audio 
instructions

English, French, Italian, German, Spanish, Korean, 
or Simplified Chinese
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You can also view the status of your smartpen, including:

• Storage available

• Battery level

• Software version

Using a Notebook’s Settings and Status Buttons

Livescribe notebooks provide printed buttons you can use to view and change settings. Some 
notebooks have more printed buttons than others for viewing and changing settings.Most notebooks 
include Settings and Status areas, with various printed buttons.

Using the Settings area printed buttons you can change some smartpen settings, including:

• Date and time

• Display brightness

• Scroll speed

• Display orientation

• Audio volume and mute
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The Status area provides buttons you can use to view current smartpen information, including:

• Date and time

• Battery level

• Storage

• Audio settings

• Software version

Setting the Date
IMPORTANT: It is critical that you set the correct time and date on your smartpen because Paper Replay 

sessions you create with your smartpen are named using the time and date they are 
created. Also, the Livescribe smartpen presents the date format as mm/dd/yy by default. 
You can change this format either before or any time after you set the date. To change the 
date format, see Setting/Viewing the Date Format on page 43.

1. With your smartpen turned on, open 
the inside cover of your notebook. 
Locate the Settings area.

 

2. Tap the Set Date button  
with the Livescribe smartpen. 
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Setting the Time

3. Tap the printed keypad and type the 
current date.
Example: Tapping 101809 sets the 
date to Sunday, October 18, 2009 for 
the date format of mm/dd/yy.
Your smartpen will now display the 
date you entered.

NOTES: 
• If you make a mistake while entering 

the date, simply tap on the Set Date 
buttons again to start over. 

• To set the date format, see 19TUSetting/
Viewing the Date Format on page 43.

1. With your smartpen turned on, open 
the inside cover of your notebook. 
Locate the Settings area.
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Setting Display Brightness

Tap the Display Brightness button  on the inside covers of your notebook to select between 
brightness settings. Tap multiple times to scroll through the display brightness settings. Values are 
100%, 90%, 75%, 50%, and 10%.

NOTE: The lowest brightness setting is optimal for dark room environments, such as when a speaker 
may be presenting a slideshow.

Alternatively, use the Settings menu on your smartpen to change the display brightness. 

Setting the Display Orientation

You can configure your smartpen display for either left- or right-handed use.  Tap the appropriate 
button to configure your display orientation. Alternatively, use the Settings menu on your smartpen to 
change the display orientation. 

2. In your notebook, tap the Set Time 

button  with the Livescribe 
smartpen. 

3. Tap the printed Settings keypad and 
enter the time as “hh:mm” format. Tap 
the “AM” or “PM” button to select AM 
or PM. For example, to enter 
12:01PM, tap “1,” “2,” “0,” “1,” and the 
“PM” button.
Your smartpen will now display the 
time you entered.

NOTES: 
• If you make a mistake, entering the 

time, simply tap on the Set Time but-
tons again to start over. 

• To set the time format, see USetting/
Viewing the Time Format on page 43.
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1. With your smartpen turned on, open the inside 
cover of your notebook. Locate the Settings 
area.

 

2. Under Settings, tap on the Left or Right button 
to orient your display for left- or right-handed 
use.  

Setting Scroll Speed of the Display

Text that is too long to fit on your smartpen display will scroll across the display. You can increase or 
decrease the rate at which text scrolls using the Scroll Speed settings.

• To increase the scroll speed, tap the  button. 

• To decrease the scroll speed, tap the printed  button.

• Tap until you reach the desired speed, between 1 and 10.

You can also view and set scroll speed using the Settings menu. See Setting/Viewing Scroll Speed on 
page 42.
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Viewing Playback Latency

To view the current playback latency setting, tap on the audio settings button  on the inside 
cover of your notebook. 

You can also view and set playback latency using the Settings menu. See Setting/Viewing Playback 
Latency on page 42. Or, view the current setting using a quick command. See Viewing Audio Settings 
with a Quick Command on page 60.

Viewing Audio (Recording) Quality Settings

To view the current audio (recording) quality, tap on the audio settings button  on the inside 
cover of your notebook. 

You can also view and set audio (recording) quality using the Settings menu. See Setting/Viewing 
Audio (Recording) Quality on page 41. Or, view the current setting using a quick command. See 
Viewing Audio Settings with a Quick Command on page 60.

Viewing Microphone Sensitivity Settings

To view the current microphone sensitivity, tap on the audio settings button  on the inside cover 
of your notebook. 

You can also view the microphone sensitivity setting using the Settings menu. See Setting/Viewing 
Microphone Sensitivity on page 41. Or, view the current setting using a quick command. See Viewing 
Audio Settings with a Quick Command on page 60.
Livescribe™ Smartpen User Guide 35



Viewing the Date and Time

1. Tap the Time button 
to check the current 
time.  

2. Tap the Date button 
to check the current 
date.  

You can also view the date and time using a quick command. See Viewing the Time and Date with 
Quick Commands on page 65.

Viewing the Battery Level

1. Tap the Battery 
button to see the 
current battery 
charge. The indicator 
pictured shows a full 
battery.

 

You can also view the battery level using a quick command. See Viewing the Battery Level with a 
Quick Command on page 63.
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Viewing Storage Available

1. Tap the Storage button once to see 
amount of remaining storage in 
megabytes and tap a second time 
to see the remaining recording 
time based on the current audio 
(recording) quality settings. 

 

IMPORTANT: If you see the circled 
exclamation mark 
indicator on the right side 
of the display, check your 
available memory on the 
Livescribe smartpen as it 
is almost full.

You can also view the available storage using a quick command. See Viewing Available Storage with a 
Quick Command on page 61.

Viewing the Software Version

Tap the Software version button to see 
the current version of software installed 
on your smartpen.

 

NOTE: If available space is less than 1 
MB, your smartpen will display 
memory in available KB. 
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Using the Settings Menu
Using the Settings Menu

Using the Settings menu, you can change and view settings of the Livescribe smartpen, including:

Setting Values

Audio (Recording) quality High, Medium, Low

Microphone sensitivity Conference room, Lecture hall, Automatic

Playback latency On, Off

Menu Voice On, Off

Display brightness 100%, 90%, 75%, 50%, 10% 

Display orientation right-handed, left-handed

Auto-off time 30 minutes, 1 hour (default), 2 hours, 4 hours

Scroll speed 1-10 (1 is slowest, 10 is fastest)

Display orientation right-handed, left-handed

Date format mm.dd.yy, dd.mm.yy, yy.mm.dd

Time format 12-hour, 24-hour

Locale English

Français

Español 

Deutsch

Italiano

Chinese

Korean

TIP:  In the Settings menu, active options appear with a checkmark on the display. 
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Using the Settings Menu
1. Double-tap the center of a Nav Plus to go the 
Main Menu. 

 

  

2. Tap down until Settings is displayed.

 

3. Tap right to select Settings. 

  

4. Tap down and up to scroll through the setting 
types list.
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Using the Settings Menu
5. Tap right to select a setting type. 

  

6. Tap down and up to scroll through the setting 
options list.  

    

7. Tap right to select an option. After activating an 
option, a confirmation message will scroll 
across your smartpen display and the active 
option will have a checkmark beside it in the 
display.

  

8. Tap left to return to the option setting list to 
make a different selection. 
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Using the Settings Menu
Setting/Viewing Audio (Recording) Quality

Use the Audio (Recording) quality setting to change the compression rate of the recorded AAC audio: 
the higher the audio quality, the lower the compression rate. As a result, files recorded with the highest 
audio quality setting will be larger files that require more storage space. 

• Use High to record at the highest audio quality. This setting will require the largest amount of 
storage space and is optimal for very large environments or when the highest quality recording is 
required.  

• Use Medium  to return to the default recommended audio quality setting.  

• Use Low to record at lowest audio quality. This is a memory-saving setting that will utilize the least 
amount of memory and is optimal for dictations or smaller quieter recording environments. 

NOTE: You cannot change these settings during recording. Always select the appropriate audio quality 
setting before beginning a recording.

Setting/Viewing Microphone Sensitivity

You can set your smartpen microphone sensitivity for different recording situations. 

• Use Conference Room  to set the microphone sensitivity for quieter environments where the person 
speaking is closer to the microphone. This setting is optimal for dictations, offices, or small 
conference rooms. 

• Use Lecture Hall  to set the microphone to pick up sounds in a wider open area. This setting is 
optimal for large rooms where the speaker’s voice is distant from your smartpen microphone. We 
also recommend the use of the 3-D Recording Headset when recording in this type of environment. 

• Use Automatic to let your smartpen automatically set your microphone sensitivity based on the 
noise level of your environment. This is the recommended default setting for the Livescribe 
smartpen.

9. Tap left again to return to the option list to 
select a different option.
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Using the Settings Menu
NOTE: You cannot change settings while your smartpen is recording. Always select the appropriate 
microphone setting before beginning a recording. The microphone will stay set at the last setting 
you used.

Setting/Viewing Playback Latency

When you tap your notes to play back a Paper Replay™ session, the audio will play from a moment 
five seconds before the note was actually written. This allows you to more accurately replay the 
moment because there is natural delay between the time when you hear an important point and the 
time when you begin writing.

Set the Playback Latency to Off  to turn off this latency. You will want to do this if you are playing back 
a recording in which your audio and writing are perfectly synchronized. 

Enabling/Disabling the Menu Voice

Your smartpen voice audibly announces certain menu items, specifically items in the Main Menu and 
in Applications menu. Set Menu voice to Off to disable it. 

NOTE: Turning off the Menu Voice will not affect Paper Replay™ audio or other smartpen sounds.

Setting/Viewing Display Brightness
To change the brightness of your smartpen display, use the Settings menu. Values are 100%, 90%, 
75%, 50%, and 10%.

NOTE: The lowest brightness setting is optimal for dark room environments, such as when a speaker 
may be presenting a slideshow.

Setting/Viewing Scroll Speed

To change the scroll speed of your smartpen display, use the Settings menu on your smartpen 
available through the Nav Plus. Values are 1-10. 1 is slowest and 10 is fastest.
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Using the Settings Menu
Setting the Auto-Off Time 

You smartpen has an auto-off feature to save power after long periods of inactivity. Using the Auto-Off 
Time option, you can set the length of time before your smartpen automatically powers off. You can set 
the auto-off time as 30 minutes, 1 hour (the default), 2 hours, and 4 hours. 

To set the auto-off time, use the Nav Plus to go to Settings > Auto-off Time. Select the desired time 
and Tap right. 

NOTE: The auto-off time setting persists until you change it or the smartpen is completely reset.

Setting/Viewing Display Orientation

To change the orientation of your smartpen display, use the Settings menu. Values are right-handed 
and left-handed.

Setting/Viewing the Date Format

To change the date format to “mm/dd/yy”, “dd/mm/yy”, or “yy/mm/dd”:

• Use the Settings menu and navigate to the Date Format option and select either mm/dd/yy, dd/
mm/yy, or yy/mm/dd.

Setting/Viewing the Time Format

To change the time format between 12 hour and 24 hour:

• Use the Settings menu and navigate to the Time format option. Select either 12 hour or 24 hour.

Viewing the Smartpen Name

If you use Livescribe Desktop to name your smartpen, you can view its name when the smartpen starts 
up or at any time using the Nav Plus to go to Settings > Smartpen Name.
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Switching Languages (Locales)
Switching Languages (Locales)

You can use the Locale command in the Settings menu to change your Livescribe smartpen display 
and audio instructions from one language to another. When you switch to another language, your 
smartpen will change these things based on the locale:

• Language of text resources (such as menus and other on-screen prompts)

• Language of audio resources (such as application names and instructions)

• Date format

• Time format

• Number format

Livescribe also provides printed controls to switch between languages. See Using the Language 
Switch Card for Chinese and Korean on page 44 and Using the Getting Started Guide Controls to 
Switch Locales on page 45.

To use the Locale command in the Settings menu:

1. Use the Settings menu and navigate to the Locale option. Select one of the available locales. This 
list includes:

• English

• Français

• Español 

• Deutsch

• Italiano

• Chinese

• Korean

2. When prompted, tap right again to restart your smartpen. After your smartpen restarts, it will run 
with the selected language as the default. 

Using the Language Switch Card for Chinese and Korean

You can use the Language Switch Card to switch your Livescribe smartpen from English to Chinese or 
Korean. 
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Switching Languages (Locales)
For example, to switch from English to Korean:

1. Tap the Korean button .

2. Tap the button again to restart your smartpen. After your smartpen restarts, it will run with Korean 
as the default locale.

Using the Getting Started Guide Controls to Switch Locales
The Getting Started Guide that ships with your Livescribe smartpen may have printed controls to 
switch your smartpen from English to other languages. If it does, you can use these controls as fol-
lows. Otherwise, use the Settings menu to switch locales: 

For example, to switch from English to German:

1. Tap the Deutsch button .

2. Tap the button again to restart your smartpen. After your smartpen restarts, it will run with German 
as the default locale.
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5 Navigating the Main Menu
You can use the Main Menu of the Livescribe smartpen to locate applications and settings for the Live-
scribe smartpen. This topic describes how to navigate around the Main Menu and use other tech-
niques to quickly get to applications and information you want. Topics covered include:

• Using the Nav Plus. See Using the Nav Plus on page 46

• Scrolling with Flick and Scrub. See Scrolling with Flick and Scrub on page 50

• Quick Commands. See Using Quick Commands on page 53.

Using the Nav Plus

The Nav Plus is a paper-based, five-way navigator that enables you to navigate through your 
smartpen Main Menu and application menus.  

Using a Pre-Printed Nav Plus

You can use any Nav Plus you see printed on any Livescribe™ dot paper product, such as the 
included notebook.  To use a printed Nav Plus:
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1. Double-tap the center of the Nav Plus. A double-tap 
is two taps in quick succession. 

NOTE: Double-tapping on the center of a Nav Plus will 
exit the current application or sub-menu and take 
you to the Main Menu. The one exception to this 
rule is that if you are recording using the Paper 
Replay™ application, double-tapping the center 
will take you to the Main Menu but background 
recording will continue.

  

2. Main Menu will be displayed on the Livescribe 
smartpen.

  

3. Tap down on the directional arrow of the Nav Plus to 
scroll through a list of applications on the Livescribe 
smartpen.  

4. When the desired application name is displayed, tap 
right to select that application. 

  

5. Tap down to scroll through the application menu.  
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NOTE: The Livescribe smartpen will display small directional arrows to indicate the directions in the 
menu that you can scroll through. 

Drawing a Nav Plus 

If a pre-printed Nav Plus is not easily accessible, create your own simply by drawing one. 

To draw a Nav Plus:

6. Tap right to select an item in the application menu 
list. 

  

7. Tap left to return to the previous menu.

 

8. To return to the Main Menu, tap a series of left taps 
or double-tap on the center of the Nav Plus to jump 
to the Main Menu. 
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1. Using any Livescribe™ dot paper 
product, such as the included Starter 
notebook, draw intersecting vertical 
and horizontal lines. You can draw the 
intersecting lines in either order. The 
lines should:
• Be fairly straight

• Be approximately the same 
length

• Intersect near their centers

 

2. WIthin one second of drawing the 
lines, double-tap in the center of the 
Nav Plus. This will complete the 
process of creating a Nav Plus. 

3. Main Menu is displayed on your 
smartpen when you have 
successfully created a Nav Plus. 

 

Nav Pluses drawn incorrectly:

NOTE: After you draw a Nav Plus, it is 
always usable for future use.

Lines are not straight.  
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Scrolling with Flick and Scrub
Scrolling with Flick and Scrub

Flick and Scrub is a way for you to quickly scroll through menu items and other displayed text on your 
smartpen. This feature is useful when text presented by an application is longer than the display can 
show horizontally or when multiple menus or options are available vertically. 

Flicking refers to quickly dragging your smartpen across paper and then lifting your smartpen off the 
paper. The contents of the display scrolls rapidly, based on the speed of your smartpen when it was 
lifted.

Scrubbing refers to dragging your smartpen across the paper. The contents on the display moves and 
scrolls in the same direction and at the same relative speed as the movement of your smartpen.

Lines do not intersect in 
the center of each line.
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Scrolling with Flick and Scrub
To use Flick and Scrub scrolling:

1. Navigate to a list of vertical menu items, such 
as Main Menu or one of its submenus, such as 
Applications or Settings. 

1. On any unused paper region, press the tip of 
your smartpen down for one-half (1/2) second.

2. Wait until you hear a short beep, then without 
lifting your smartpen tip off the paper, draw a 
horizontal or vertical line. 
Your smartpen assigns the area you draw as a 
Flick and Scrub control area for any applica-
tion. 

TIP: Instead of drawing a line, you can draw a rect-
angular box as the Flick and Scrub control 
area. You may find the box easier to use 
because it provides a wider area than a 
straight line.
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Scrolling with Flick and Scrub
Flick and Scrub Display Indicators
When using Flick and Scrub, the display shows indicators based on the direction of additional text and 
the relative position of the displayed text to the contents.

Vertical Flick and Scrub Scroll Indicator. For vertical Flick and Scrub, the scroll indicator is on the 
right side of the display. In this example, the text shown is close to the top of the current menu list. 
Therefore, the vertical scroll indicator is near the top. 

Horizontal Flick and Scrub Scroll Indicator. For horizontal Flick and Scrub, the scroll indicator is at 
the bottom. In the examples below, the display scrolls through the phrase “there were two small 

3. Move your smartpen on the flick and scrub 
control area you drew to scroll through the 
application’s display text. 
The display text will scroll either up and down 
(for vertical controls) or left and right (for hori-
zontal controls), depending on the direction in 
which you drew the control. 

NOTE: You can use both flicking and scrubbing 
motions on the same control area. You do 
not need to draw a separate area for flicking 
and another for scrubbing. However, you will 
need separate control areas for vertical and 
horizontal scrolling.

TIP: After you have created a Flick and Scrub 
control region, you can use it at any time for 
scrolling. This is similar to the way you can re-
use a hand-drawn Nav Plus after creating it.  
To return to use the Flick and Scrub region you 
do not need to press down the smartpen tip 
again for 1/2 a second. This is only needed 
when first creating the region.
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Using Quick Commands
children”. The scroll bar along the bottom shows how far through the phrase the current display is. The 
first display shows the position near the beginning of the phrase. 

The second display shows the scroll bar position near the middle of the phrase after scrolling the 
display horizontally. 

Using Quick Commands

Quick Commands let you write a one-line command with the Livescribe smartpen and get an 
immediate response on your smartpen display.  Quick Commands are useful when you do not have 
access to the Status buttons on the inside cover of your Livescribe notebooks, or if you need to do a 
quick calculation while writing.

The following is a list of Quick Commands available on the Livescribe smartpen. 

NOTE: Quick Commands are not case sensitive.

• Launch an application. See Launching Applications with a Quick Command on page 54.

• Show the top session in the Paper Replay™ “Play Session” list. See Locating and Playing a Recent 
Session with a Quick Command on page 56.

• Write and solve a quick calculation. See Doing Basic Math Calculations with a Quick Command on 
page 58.

• Show available battery power. See Viewing the Battery Level with a Quick Command on page 63.

• Show your audio (recording) quality settings. See Viewing Audio Settings with a Quick Command 
on page 60“.

• Show your remaining smartpen storage. See Viewing Available Storage with a Quick Command on 
page 61.
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Using Quick Commands
• Show the current time or date. See Viewing the Time and Date with Quick Commands on page 65.

Launching Applications with a Quick Command
Quick Launch is a Quick Command you can use to start smartpen applications. You can use Quick 
Launch to start any applications available in the Main Menu and other folders within it.

NOTE: You can write Quick Launch commands in your native language for certain Livescribe smartpen 
applications. For example, a German user can launch Piano by creating a Quick Launch 
command named Klavier. 

1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.

 

2. Your smartpen displays the Quick Command 
indicator (asterisk) in the Main Menu. It is 
waiting for you to write a Quick Command.
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Using Quick Commands
3. Within three (3) seconds, write the first few 
letters of the application you want to launch.  
For example, writing “Pi” would scroll your 
display to the Piano application. Writing the 
letters “Pa” would scroll to Paper Replay. 
Writing the letter P, would scroll to the first 
application that begins with the letter P. From 
there, you can scroll to the specific application 
you want to start using the Nav Plus or Flick 
and Scrub. See Scrolling with Flick and Scrub 
on page 50 for more information.

NOTE: Using its predictive text feature, your 
smartpen will display the first application 
that matches your written input. As soon as 
you see the application you want on the 
display, you can stop writing.  

 

4. Tap right on the Nav Plus, or double-tap on any 
open paper.

5. Your smartpen will leave Quick Launch and 
start the application.
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Using Quick Commands
Locating and Playing a Recent Session with a Quick Command

Use the Play Quick Command to get fast access to your saved Paper Replay™ sessions. To quickly 
show the top item in your “Play Session” list:

TIP: Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command. That is, you can re-launch the 
application at any time by tapping your Quick 
Command.

 

1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.

 

2. Your smartpen will display the Quick Command 
indicator in the Main Menu. It is waiting for you 
to write a Quick Command.
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Using Quick Commands
3. Within three (3) seconds, write the word “play.”  

NOTE: Using its predictive text feature, your 
smartpen will display the first command that 
matches your written input. In this case, 
“play” is displayed as soon as you write “p”. 
As soon as you see the command you want 
on the display, you can stop writing.   

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.

5. Your smartpen will display the top item in the 
Play session list. You can tap down using the 
Nav Plus to scroll through sessions and then 
tap right to begin playback.  

6. Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command.
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Using Quick Commands
Doing Basic Math Calculations with a Quick Command

You can use the Calc Quick Command to perform basic mathematical calculations.

1. Double-tap the center of a Nav Plus. A double-
tap is two taps in quick succession.

 

2. Your smartpen will display the Quick Command 
indicator in the Main Menu. It is waiting for you 
to write a Quick Command.

 

3. Within three (3) seconds, write the word “calc.”  

NOTE: Using its predictive text feature, your 
smartpen will display the first command that 
matches your written input In this case, calc 
is displayed as soon as you write a “c”. As 
soon as you see the command you want on 
the display, you can stop writing.   

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.
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Using Quick Commands
Guidelines for Writing a Math Problem:

• Numbers can contain up to 12 characters, including a decimal point.

• Operators can include +, -, ×, *, /, and ÷.

• You can double-tap instead of writing the equals sign. 

Example: 52 - 14 followed by a double-tap is an accepted entry. 

NOTE: If the length of the math problem exceeds the display size, the beginning of the problem scrolls 
off the left of the display as new characters are added to the right.

5. Your smartpen will prompt you to write a 
problem. 

 

6. Write a basic math problem, such as 51 x 3 =

 

7. Your smartpen will display the result.

 

8. Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command.
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Using Quick Commands
Viewing Audio Settings with a Quick Command

To display the status of audio settings on the Livescribe smartpen, including:

• audio (recording) quality

• microphone sensitivity

• playback latency

1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.

2. Your smartpen will display the Quick 
Command indicator in the Main Menu. It is 
waiting for you to write a Quick Command.

  

3. Within three (3) seconds, write the word 
“audio.” 

NOTE: Using its predictive text feature, your 
smartpen will display the first command 
that matches your written input. In this 
case, audio is displayed as soon as you 
write “a”. As soon as you see the command 
you want on the display, you can stop 
writing.  
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Using Quick Commands
Viewing Available Storage with a Quick Command

To display the amount of available memory on the Livescribe smartpen:

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.

5. Your smartpen will display its audio settings.

 

6. Once you have written a Quick Command, 
you can tap where you wrote it to repeat the 
command.
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Using Quick Commands
1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.

  

2. Your smartpen will display the Quick Command 
indicator in the Main Menu. It is waiting for you 
to write a Quick Command.

 

3. Within three (3) seconds, write the word 
“storage.” 

NOTE: Using its predictive text feature, your 
smartpen will display the first command that 
matches your written input In this case, 
storage is displayed as soon as you write an 
“s”. As soon as you see the command you 
want on the display, you can stop writing.  

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.
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Using Quick Commands
Viewing the Battery Level with a Quick Command

To view the current battery level of your Livescribe smartpen:

5. Your smartpen will display the available 
memory.

NOTES: 
• If available space is less than 1 MB, your 

smartpen will display memory in available KB. 
• If you see the circled exclamation mark indica-

tor on the right side of the display, check your 
available memory on the Livescribe smartpen 
as it is almost full.  
To learn about managing your smartpen stor-
age, see Deleting Paper Replay™ Sessions on 
page 83 in this guide and Managing your 
Smartpen in the Livescribe Desktop User 
Guide. 

6. Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command.
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Using Quick Commands
1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.

 

2. Your smartpen displays the Quick Command 
indicator (asterisk) in the Main Menu. It is 
waiting for you to write a Quick Command.

  

3. Within three (3) seconds, write the word 
“battery.”  

NOTE: Using its predictive text feature, your 
smartpen will display the first command that 
matches your written input In this case, 
battery is displayed as soon as you write a 
“b”. As soon as you see the command you 
want on the display, you can stop writing.  

 

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.
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Using Quick Commands
Viewing the Time and Date with Quick Commands

You can use Quick Commands to check the time or date. Or, you can check the current Time and Date 

by tapping on the printed Time  and Date  buttons on the inside cover of your notebook 
under Status. 

5. Your smartpen will display the remaining 
battery power.

6. Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command.

 

1. Double-tap on the center of a Nav Plus. A 
double-tap is two taps in quick succession.
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Using Quick Commands
2. Your smartpen will display the Quick Command 
indicator in the Main Menu. It is waiting for you 
to write a Quick Command.

  

3. Within three (3) seconds, write either “date” or 
“time.”  

NOTE: Using its predictive text feature, your 
smartpen will display the first command that 
matches your written input. In this case, 
date or time is displayed as soon as you 
write a “d” or “t”. As soon as you see the 
command you want on the display, you can 
stop writing.

 

4. Right-tap on the Nav Plus, or double-tap on 
any open paper.

5. Your smartpen will display the date or time. 
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Launch Line and Tap Around
Launch Line and Tap Around

Using Launch Line is similar to Quick Launch. You can use Launch Line to quickly launch any Open 
Paper application installed on your smartpen. Open Paper applications are applications that do not 
require pre-printed paper controls to function. Examples of these applications are Piano, Translator 
Demo, and most applications on the Livescribe Online Store.

Tap around is a feature of Launch Line that is an alternative to using the Nav Plus to navigate menus 
of an application.The areas immediately surrounding a Launch Line function as the Nav Plus controls: 
Tap Up, Tap Down, Tap Left, Tap Right, and Tap Center.

The tap-around regions correspond to the features and regions of the Nav Plus, except that:

• Tap around controls menus and navigation within its corresponding application only.

• You cannot use tap around controls to launch other applications.

To create and use Launch Line and tap around:

6. Once you have written a Quick Command, you 
can tap where you wrote it to repeat the 
command.
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Launch Line and Tap Around
1. Draw a horizontal line on your notebook (starting 
from right or left) and without removing your 
smartpen tip from the page, immediately double 
back on the line ending close to where you started. 

2. Immediately write the name of the target application 
above the line.

 

3. To launch an application, tap on the application 
name you have written. 

  

4. You can use the tap around feature to navigate the 
application: Tap just above (as shown), below, left, 
or right of the name to perform the corresponding 
functions of the Nav Plus. 

5. After creating a Launch Line, it remains as an active 
“button” that you can tap at any time to launch the 
application. 

NOTE: Using its predictive text feature, your smartpen 
will display the first command that matches your 
written input.

NOTE: If the text you write is a unique match to an 
application, the application will launch 
automatically.
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6 Using the Paper Replay™ 
Application
With the Paper Replay™ application, your smartpen records audio and links it to what you write. Later, 
you can tap on any of your notes and hear the audio recorded from that moment. 

Whenever you turn on the Livescribe smartpen, it captures a digital copy of your notes, whether or not 
you also choose to record audio.

The Paper Replay™ control bar printed at the bottom of every notebook page lets you begin and end a 
recording as well as manipulate the playback of your recording.  

NOTE: The Paper Replay™ printed controls are not page-specific. You can tap Record on one page, 
begin recording, and then tap Stop on a different page and the Livescribe smartpen will stop 
recording. 

About Paper Replay™ Sessions

When you begin recording with the Livescribe smartpen, your smartpen automatically links the audio 
to anything you write on Livescribe™ dot paper. The recorded audio (and any associated written 
notes) is called a Paper Replay™ session. A session begins when you start recording audio and ends 
when you stop recording audio. A paused recording is still one session. A session always contains 
audio and optionally can contain associated written notes (pages).

A session can be any length of time and does not necessarily equal a single page. For example, if you 
start and stop recording multiple times per page, you will have multiple Paper Replay™ sessions on 
one page. Conversely, you may also have one Paper Replay™ session that spans multiple pages.   

The Paper Replay™ playback controls such as jump, position bar, and bookmark, function within a 
single Paper Replay™ session. You can jump forward or back or speed listen to only one Paper 
Replay™ session at a time.  If you created multiple Paper Replay™ sessions on one page, you will 
need to tap on the notes associated with the specific desired recording to begin playback. After starting 
playback, you can then use the playback or bookmark controls to listen to that session.
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Recording Sessions
When you tap on the playback controls before tapping on any of the written notes on a page, your 
most recently accessed audio recording will play back regardless of whether that recording or 
those notes are on the current page. This feature allows you to quickly replay your last recording even 
if you have forgotten to write notes on paper.

Recording Sessions

IMPORTANT: Do not record without permission. By using Livescribe products and services, you agree to 
comply with all laws regarding recording.

There are three ways to begin recording audio with the Livescribe smartpen:

• Starting Recording with a Pre-Printed Record button on page 70.

• Starting Recording Using Quick Record on page 70

• Starting Recording Using a Nav Plus on page 71

TIP: While you are recording with Paper Replay, you can use the Nav Plus to perform any normal set of 
functions, such as scrolling through the menus and launching applications.

Starting Recording with a Pre-Printed Record button

1. Tap the Record button  on the bottom of your notebook with the tip of your smartpen. 

2. While your smartpen is recording, you will see an incrementing timer on your display.  

 

NOTE: After you initiate a recording, you can use other applications on the Livescribe smartpen, such 
as the Calculator. A blinking Record icon will appear in the bottom right corner of your display to 
indicate that recording is still in progress. To learn more, see Using Background Recording on 
page 86.

Starting Recording Using Quick Record
1. Press the Power button to turn on your smartpen.
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Recording Sessions
2. Press and hold the Power button for approximately five seconds until the display indicates that the 
recording started. 

 

NOTE: If your smartpen is off, press and hold the Power button until the start sequence and the word 
“REC…” appear on the display.  Also, if you write on Livescribe™ dot paper after starting 
recording with Quick Record, your smartpen will link your notes and audio. 

Starting Recording Using a Nav Plus

1. Double-tap on the center of the Nav Plus to 
go to your smartpen Main Menu.  

 
 

2. Tap down until Paper Replay™ is displayed. 
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Stopping a Recording or a Session Playback
Stopping a Recording or a Session Playback

There are three ways to stop recording or playback of a session:

• Tap the Stop button  on the bottom of your notebook. 

• Turn Power off.

• Use the Nav Plus label to stop recording.  

3. Tap right to launch the Paper Replay™ 
application. You will see the Record new 
session option. 

4. Tap right to select Record new session. The 
display will indicate that recording has been 
initiated.  

1. During recording, single-tap the center of the 
Nav Plus. Your smartpen will display Stop 
Session. 
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Pausing/Resuming a Recording or Session Playback
Pausing/Resuming a Recording or Session Playback

You can suspend recording or audio playback of a session with the Pause button  printed on 
the bottom of each notebook page. To resume recording or playback, simply tap Pause a second time. 
While your smartpen is paused, a pause icon will appear on the display. 

Paused during Playback

 

Paused during Recording

 

While your smartpen is paused, it will continue to capture a copy of your digital notes. Any notes that 
you write after you tap pause are linked to the audio that occurred the moment before you tapped 
Pause. When you tap on notes that were written while paused, your smartpen will play back the 
recording from the moment just before you tapped Pause. 

Playing a Session

There are three ways to play back a session: 

2. Tap right to stop recording of the session 
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Playing a Session
Play a Session by Tapping on Your Notes

Tap any note of the notes you wrote while you recorded using the Paper Replay™ application. The 
recorded audio will play back from the moment the notes were taken. During playback, your smartpen 
display will indicate the current position in the recording and the time remaining in your recording. 

 

TIP: As you record, remember to write something down on your notepad so that you can begin playback 
by tapping on those notes. If you do not do this, you can instead browse a list of audio sessions 
stored on your smartpen with the Nav Plus. 

Play a Session by Tapping on Notebook Buttons

Tap on any of the following printed buttons in your notebook to access the most recently recorded or 
played back session. 

Jump forward/back

Position bar

Bookmark

Play a Session using the Nav Plus

Use the Nav Plus to browse a list of audio sessions and select the audio file by timestamp:
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Playing a Session
1. Double-tap the center of the Nav Plus to reach your 
smartpen Main Menu.  

 

  

2. Tap down until Paper Replay™is displayed. 

 

3. Tap right to select the Paper Replay™ application 
menu. The first item in the list is Record new 
session. 

 

4. Tap down to locate Play Session.  
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Controlling Session Playback
Controlling Session Playback

There are various ways that you can control the playback of an audio file on your smartpen and quickly 
locate any section of the audio file. All of the controls mentioned below are available on the bottom of 
each page of your notebook.

Changing Playback Volume 

Use the Volume controls  to raise or lower the playback volume or mute playback 
entirely. After muting the playback, you can un-mute it by tapping the mute button a second time.

5. Tap right to view a list of sessions listed using their 
timestamp. 

 

1. Tap down to scroll through the list of sessions.  

 

2. Tap right to select the audio session that you want 
to open. Playback will begin. 
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Controlling Session Playback
Jumping Forward and Backward

You can jump back or forward 10 seconds in an audio file by tapping on the Jump controls .

Speed Jumping

Tap and hold down the Jump Back or Jump Forward button  to continuously jump through 
an audio file. As you continue to speed jump, the length you jump increases.

Jumping to a Position

If you want to quickly jump to the beginning, end, or any position within an audio session, use the 
Jump to Position bar.  

• Tap anywhere on the position bar to jump to the corresponding position in the audio file.

• Tap the 0% button to jump directly to the beginning of the current audio session.

Changing Playback Speed

If you want to speed listen to the audio file or slow the audio session to replay a specific moment, use 

the Playback Speed controls .  

• To slow down the audio from normal speed, tap the Slow Down Audio  button. Tap repeatedly 
to keep slowing down audio speed.

• To speed up the audio from normal speed, tap the Speed Up Audio  button. Tap repeatedly to 
keep increasing the playback speed.

• To return to normal speed—the speed at which the audio was recorded—tap the Normal Audio 

Speed  button.
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Setting Session Bookmarks
NOTE: Audio that is played back either sped up or slowed down is no longer in stereo. Audio plays in 
mono until it is returned to normal speed. 

Setting Session Bookmarks

Bookmarks allow you to flag a section of audio and later jump to it quickly and easily. You can add 
bookmarks as you record, or add them later when listening to your recording.

Adding Bookmarks 

• Tap the Bookmark button  during either recording or playback. A bookmark will be placed at 
that point in the audio file.

Adding a bookmark during recording

 Adding a bookmark during playback

 

Reviewing Bookmarks

After you have added bookmarks to an audio session, you can scan through the bookmarks using the 

Previous  and Next   bookmark buttons. 

During playback, your smartpen display will indicate the bookmarks in the audio timeline. 
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Recording Paperless (Audio Only) Sessions
Recording Paperless (Audio Only) Sessions

If you want to record audio but cannot or do not want to write on Livescribe™ dot paper, you can create 
a paperless or pageless Paper Replay™ session. 

NOTES: 
• When recording a paperless session, you can at any time, link the recording to written notes by writ-

ing on Livescribe™ dot paper. At that point, the paperless session will be associated with your 
notes and will no longer be paperless. 

• Similarly, if you have previously recorded a paperless session, you can play it back and begin writ-
ing on Livescribe™ dot paper. The paperless session will be associated with your notes and will no 
longer be paperless. See UAnnotating - Linking Notes to Pre-Recorded Sessions on page 80.

To create a paperless session, begin recording audio but do not take any notes. You can start a 
paperless session in various ways:

• Tapping the Record button on any notebook (see Starting Recording with a Pre-Printed Record 
button on page 70)

• Using the Quick Record feature (see Starting Recording Using Quick Record on page 70).

• Using the Nav Plus (see Starting Recording Using a Nav Plus on page 71

The new paperless session will appear in the Paper Replay™ session list.

To access a paperless session, use the Nav Plus to browse Paper Replay™ sessions stored on the 
Livescribe smartpen. Your smartpen indicates a paperless session with an asterisk (*) next to the 
filename in the Select Session list. 
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Annotating - Linking Notes to Pre-Recorded Sessions
 

NOTE: If recording the paperless session was the last action you took with the Livescribe smartpen, you 
can also access the session by tapping on the 0% point of the paper control position bar.

Annotating - Linking Notes to Pre-Recorded Sessions

You can write new notes and link them to a previously recorded audio file by writing on dot paper while 
you play back the audio recording. Your recorded audio can be already linked to your notes, or 
paperless (see Recording Paperless (Audio Only) Sessions on page 79). This feature is very useful 
when you need to clarify or expand on your notes later. For example, you may need to go back to your 
notes to correct or clarify a point made in a meeting or lecture. Those written corrections are linked to 
your original recorded audio.

To link notes to previously-recorded audio:

1. Start audio playback by tapping on your partially written notes or using Nav Plus to play a 
previously-recorded session. 

2. After you start playback, begin writing with the Livescribe smartpen. Your smartpen automatically 
links your new notes to your previously recorded audio.

3. Stop playback.

4. Tap on your newly written notes to play back the audio that you linked while writing the new notes. 
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Browsing Paper Replay™ Sessions
Browsing Paper Replay™ Sessions

1. Double-tap the center of the Nav Plus to go 
to the Main Menu. 

 

 

2. Tap down to scroll through the applications 
on your smartpen until Paper Replay™ is 
displayed. 

  

3. Tap right to launch the Paper Replay™ 
application menu. Record new session will 
be the first item. 

  

4. Tap down until you reach Play session.   
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Browsing Paper Replay™ Sessions
5. Tap right to browse sessions.

  

6. Tap down to scroll through a list of sessions. 
  

Paper Replay™ sessions are named based 
on the time and date they are created. For 
example, if a session is started on June 03, 
2008, at 12:22PM, it will be named and dis-
played as 06.03.08 12:22p.

NOTE: Your smartpen displays Paper Replay™ 
sessions in the order of the most recent 
with paperless sessions coming before 
regular sessions.

  

7. Tap right to select the session you want to 
play. 
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Deleting Paper Replay™ Sessions
Deleting Paper Replay™ Sessions

If you wish to delete sessions from your smartpen for any reason, such as managing storage, we 
recommend that you transfer your notes to Livescribe Desktop and then delete Paper Replay™ 
sessions from your smartpen. 

When you delete a session from the Livescribe smartpen, your paper notes associated with that file 
will no longer play back the Paper Replay™ audio that was associated with that ink. However, as long 
as you have transferred your notes to Livescribe Desktop, you can continue to replay your notes from 
your computer.

NOTE: You cannot retrieve a session after you delete it from both the Livescribe smartpen and Livescribe 
Desktop. Deleting sessions does not affect the notes on the Livescribe smartpen - they will 
remain on the Livescribe smartpen until you archive the notebook. To learn how to archive a 
paper product, see the Livescribe™ Desktop User Guide located in the Livescribe Desktop Help.

There are various ways to delete Paper Replay™ sessions from the Livescribe smartpen:

• Using the Windows Livescribe Desktop ‘Remove Session from Smartpen’ option or using the Mac 
Livescribe Desktop ‘Remove Recordings from Smartpen…’ option. For more information see 
Managing your Smartpen in the Livescribe™ Desktop User Guide. 

• Archiving your notebook, journal, or other paper product to remove all Paper Replay™ sessions 
from your smartpen for that paper product. See the Managing your Smartpen in the Livescribe™ 
Desktop User Guide for more information.

• Using the Main Menu on the Livescribe smartpen. See Deleting Sessions from the Smartpen Main 
Menu on page 83.

• Using the Delete Current Session shortcut to delete the most-recently accessed session. See 
Using the Delete Current Session Shortcut on page 86.

Deleting Sessions from the Smartpen Main Menu

To delete Paper Replay™ sessions from your smartpen using the Main Menu:
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Deleting Paper Replay™ Sessions
1. Double-tap on the Nav Plus to go to the Main 
Menu. 

 

 

2. Tap down to scroll through the applications on 
your smartpen until Paper Replay™is 
displayed. 

  

3. Tap right to launch Paper Replay. 

  

4. Tap down to locate Delete session from the 
menu. 
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Deleting Paper Replay™ Sessions
5. Tap right to browse sessions.

  

6. Tap down to scroll through a list of sessions.  

  

7. Locate the session to delete and tap right to 
select it. 

  

8. Tap right to confirm deletion. Your smartpen will 
indicate that the session is deleted. 
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Using Background Recording
Using the Delete Current Session Shortcut

You can use a shortcut to delete the current session. In this context, the current session is the most 
recently accessed session. This is the last session that was either played or recorded.

To activate the Delete Current Session shortcut:

:

1. On any Paper Replay Stop button, tap and hold for 
three seconds. Your smartpen will instruct you to tap 
again to delete the current session.

2. Tap Stop again to confirm the deletion.

Using Background Recording

With background recording, you can launch and run another Livescribe smartpen application (such as 
a calculator) while continuing to run Paper Replay™. Paper Replay™will continue audio recording in 
the background However, your smartpen will not link your notes to the audio while the other application 
is running. This is because the new application receives your smartpen input (ink and strokes). The 
newly-launched application has the focus of the Livescribe smartpen, and has control of your display 
and audio output. 

If you want to stop or pause recording, or add new index points to your recording, you must reactivate 
Paper Replay™ as the dominant application. There are several ways to make the Paper Replay™ 
application reactivate (also known as snap back) to receive input from the Livescribe smartpen:

• Tap on any of the printed Paper Replay™ controls, or on any Paper Replay™ notes you have 
written. 
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Paper Replay Password
• Do anything that would normally launch Paper Replay, such as tap in a session region or launch the 
Paper Replay™ application using the Nav Plus.

• Do not write or tap anything with your smartpen for five seconds. 

Your smartpen display will indicate background recording is in effect with a blinking recording dot in the 
lower right-hand corner of your display. 

 

IMPORTANT: TURNING OFF OR DOCKING YOUR SMARTPEN WILL STOP RECORDING.

Paper Replay Password

You can use Paper Replay Password to set a password for your Paper Replay sessions. Setting a 
password can prevent others from listening to your recorded audio on your smartpen. When Paper 
Replay is protected, audio play back is prevented until the password is entered. The password is a 
four-digit number. 

To use Paper Replay Password:

1. From the Main Menu, Tap down to locate Paper 
Replay.

2. Tap right to launch Paper Replay.

3. Tap down to Password protection. 

4. Tap right to set your password. 
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Paper Replay Password
Canceling Paper Replay Password

To cancel Paper Replay password and erase your password:

5. On your notepad, write four digits as your password.
To disguise your written password, Livescribe rec-
ommends using one of these methods:
• Write the numbers in a different order, for 

example backwards.
• Write the numbers in various places on the 

page.
• After writing and confirming your password, go 

back and write other numbers over your 
password to disguise it.

6. When you are finished entering your password, tap 
right on the Nav Plus. Your smartpen will confirm the 
password is set.

7. After setting your password, your smartpen will 
prompt you each time you try to play back a session. 
To listen to your sessions, write your password on 
your notebook when prompted by your smartpen. 
You smartpen will confirm if your password is 
correct.

1. Use the Nav Plus to navigate to the Paper Replay > 
Password protection > Remove password.
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Paper Replay Password
NOTE: You can also cancel password protection and remove your Paper Replay password using 
Livescribe Desktop. This is useful if you forget your password and need to regain access to your 
Paper Replay sessions. The Livescribe Desktop you use to cancel the password must be 
registered to the same account as your smartpen. You must dock your smartpen as well to 
remove the password. See the Livescribe Desktop User Guide for instructions.

2. Tap right on the Nav Plus to remove the password 
and cancel password protection. 

3. At the prompt, write the current password to be 
removed.

NOTE: Passwords are not saved when password 
protection is turned off. The previous password is 
permanently erased. When you reactivate 
password protection, you will need to set a new 
password. You can re-use passwords. They are 
not tracked across uses.

4. Your smartpen will confirm the password is 
removed.
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7 Additional Applications
In addition to Paper Replay, your Livescribe smartpen includes other applications, including:

• Printed Calculator. See Using the Printed Calculator on page 90.

• Translator Demo. See Using the Translator Demo on page 93.

• Piano. See Using the Piano on page 98.

You can also purchase additional applications from the Livescribe Online Store. See Getting New 
Applications on page 103.

Using the Printed Calculator

The calculator located on the inside covers of your notebook performs basic math functions, as well as 
many useful scientific functions. To use the calculator, tap on the printed keys with the tip of the 
Livescribe smartpen. 
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NOTE: A stylus is available for purchase from the Livescribe web store. Use the stylus instead of an ink 
cartridge to keep your calculator free and clear of ink marks. For information on using the stylus, 
please see Using a 3-D Recording Headset on page 26. 

Basic Math Functions

The calculator displays results and accepts input of numbers up to a length of 11 characters. If a result 

is longer than 11 digits, the calculator displays it in exponential notation. You can tap on the  key to 
toggle between positive and negative numbers.

Using Basic Math Operators

Basic math operators function like a typical desk calculator. Tap a number, an operator, another 
number, and an equal sign to see the answer displayed.

If you tap the equal sign directly after the operator, the calculator performs the operation on the initial 
number that you tapped. 

Example: Tap ‘6 x =’. The displayed result is 36.

If you tap more than one operator in a row, only the last operator is kept. 

Example: Tap ‘6 x + 4 =’. The result is 10. The ‘+’ replaces the ‘x’.

If you tap the equal sign repeatedly in succession, it will repeat the previous calculation. 

Example: Tap ’3 + 4 = =’ The initial result is 7. Then, 4 is added to 7 equaling 11. 

Using Parentheses in Expressions

Normally the calculator respects the standard order of operations in an extended expression. However, 
you can use parentheses in an expression to control the sequence of execution. You can nest 
parentheses in order to further control of the calculation sequence. Each time you tap a close 
parenthesis, the calculator calculates and displays the result of the enclosed expression.
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Using Clear Entry (CE) and Clear (C) Keys

Tap the  key to clear the current entry. Tap the  key to clear an entire expression, 
including any pending operator. Neither key clears values in memory.

Using Memory Keys

You can store numbers in the memory register. When a value is present in memory an M indicator 
appears. When the value in memory changes, the indicator on your smartpen display blinks. When the 
value in memory is zero, the memory indicator disappears. 

 
Adds the currently displayed 
value to the value in the memory 
register. 

 
Subtracts the currently displayed 
value from the value in the 
memory register.

 
Displays the value currently in the 
memory register. 

 
Sets the memory value to “0”. 

Using Scientific Functions

The Scientific section of the calculator includes several specialized operators and functions. 

Using Special Math Operators

For some scientific calculations, you only need to enter one number followed by an operator to obtain 

a result. These include: , , , , , , , and . When you enter a 
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Using the Translator Demo
number followed by one of these keys, the result is displayed immediately. Example: To square 7, tap 

‘7 ’. The result is 49. 

You can use the  key to raise a number y to the power of a number x. Example: Tap raise 2 to the 

power of 3, tap ‘2  3 =’. The result is 8.

You can use the  key to generate a random number between 0 and 1. 

Using Trigonometry Functions

Trigonometric calculations such as sine, cosine, and tangent must be made in degree, radian, or 
gradian mode. The calculator is in degree mode by default, and returns to degree each time you turn 
off your smartpen. 

The  key toggles between degree, radian and gradian mode. If you use a trigonometry 

function, or use the  key to change modes, an indicator of the current mode will appear. 

NOTE: You cannot use the  key to convert a completed calculation. Use it to set the mode before 
beginning the calculation.

Using the Translator Demo

With the Translator Demo, you can translate a small set of words and the numbers zero to nine from 
English into Spanish, Swedish, Arabic, or Mandarin. By writing a word in English in your notebook, you 
can see and hear correct translation from the Livescribe smartpen. 

Translator Demo Word List

Here are the words currently defined for the Translator Demo:

• Zero, One, Two, Three, Four, Five, Six, Seven, Eight, Nine, Ten
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Using the Translator Demo
• Hello, Goodbye

• Please, Thanks, Thank you

• Chocolate, Banana

• Water, Coffee, Beer

You can launch the Translator Demo in these ways:

• Using the Nav Plus. See Launching Translator Demo from the Nav Plus on page 95.

• Using your Written Word as a Button. See Re-Launching Translator Demo on page 96.

• You can also launch Translator Demo using Quick Launch (see Using Quick Commands on 
page 53) or Launch Line (see Launch Line and Tap Around on page 67).
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Using the Translator Demo
Launching Translator Demo from the Nav Plus

1. Double-tap the center of a Nav Plus to get to 
the Main Menu.

 

2. Tap down to scroll to the Translator Demo. 

  

3. Tap right to launch the Translator Demo menu.

  

4. Tap down to scroll through available 
languages.  
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Using the Translator Demo
Re-Launching Translator Demo

Once you write a word in the Translator Demo, the word you wrote becomes an active “button”. You 
can tap on this word at any time to launch Translator Demo. When launched, the Translator Demo will 
translate that word again into any of the Translator Demo languages. 

NOTE: You can also re-launch Translator Demo using Quick Launch (see Using Quick Commands on 
page 53) or Launch Line (see Launch Line and Tap Around on page 67).

5. Tap right to select a language.

NOTE: When your smartpen displays a language 
on its display, the translator demo is 
automatically switched into that mode, 
whether or not you tap right.

  

6. Write a word to translate. You can write in 
upper- or lower-case letters.
In this example, the English word ‘hello’ that 
you wrote is translated into its Spanish equiva-
lent Hola. 

7. Tap on the word to see and hear the 
translation.
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Using the Translator Demo
1. Tap on the word button you created 
when you launched the Translator 
Demo. 

2. Tap down to scroll through available 
languages.  

  

3. Tap right to select a language.

  

4. For example, if you select Mandarin as 
the language for the word “hello”, you 
will see and hear the Mandarin 
translation of Hello. 

 

NOTE: When your smartpen displays a 
language on its display, the 
translator demo is automatically 
switched into that mode, whether or 
not you tap right.
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Using the Piano
Using the Piano 

With Piano, you can draw a piano on your dotted paper and play music with the Livescribe smartpen. 
You can change the sound of your piano, add rhythm tracks, and add sharp and flat notes.

Launching Piano from the Nav Plus

1. Double-tap the center of the Nav Plus to reach 
the Main Menu. 

  

 

2. Tap down to scroll through the Livescribe 
smartpen menu until Piano is displayed. 

  

3. Tap right to select Piano.  

  

NOTE: You can also launch Piano using Quick Launch (see Using Quick Commands on page 53) or 
Launch Line (see Launch Line and Tap Around on page 67).
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Using the Piano
Drawing a Piano 

4. From left to right, draw 9 parallel vertical 
lines. The Livescribe smartpen display will 
display a blinking line to indicate which line 
you should draw next.  

 

5. Connect the 9 parallel lines with horizontal 
lines at the top and bottom.  

 

6. Write the letter “i” and double-tap near it. 
This is your instrument button.  
 
Tap the “i” button repeatedly to select one of 
the seven instruments: Grand Piano, 
Vibraphone, Kalimba, Steel Drum, Fiddle, 
Flute, or Celeste. 
 
Tap on your keyboard when the first letter of 
the instrument you want to play is displayed 
on the Livescribe smartpen display.
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Using the Piano
7. Write the letter “r” and double-tap near it. 
This is your rhythm tracks button. 

8. Tap the “r” button repeatedly to scroll 
through the five rhythm track options.

 

9. Next, add sharps and flats to your piano 
keyboard. After setting the instrument and 
rhythm buttons, tap left on the Nav Plus. 
The Livescribe will display Rhythms OFF. 

  

10.Tap down to reach Add Sharps & Flats. 

  

11.Tap right to activate Add Sharps & Flats.
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Using the Piano
NOTE: A stylus is available for purchase from the Livescribe web store.  You can use the stylus on your 
piano, rather than the ink cartridge. This will keep the paper free and clear of ink marks. For 
information on using the stylus please seeUsing a 3-D Recording Headset on page 26. 

12.The Livescribe will display blinking 
rectangles on your piano. Draw rectangles 
after the 2nd, 3rd, 5th, 6th, and 7th piano 
key lines, as in the display. 

 

13.Play your piano by tapping its keys on the 
paper. Tap the instrument and rhythm 
buttons to change their values. See 
Choosing an Instrument (PIano Sound) on 
page 102 and Choosing a Background 
Rhythm Track on page 102. 
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Using the Piano
Choosing an Instrument (PIano Sound)

1. Tap your “i” instrument button repeatedly to 
scroll through the instrument sounds your 
piano can play. Available sounds are:

2. Tap on your piano keyboard to select a 
sound. The first letter of the instrument you 
want to play shows on the Livescribe 
smartpen display.

 

Choosing a Background Rhythm Track

• Tap the “r” rhythm track button repeatedly to 
scroll through the available background 
rhythm tracks.

 

Turning Off the Rhythm Track

There are two ways to turn off the rhythm track:

• Grand Piano

• Vibraphone

• Kalimba

• Steel Drum

• Fiddle, Flute

• Celeste
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Getting New Applications
• Tap left on the Nav Plus. The Livescribe will 
display “Rhythms OFF.” Tap right on the 
Nav Plus to stop the rhythm track. 

  

• Tap the “r” button to scroll through the 
rhythm tracks until no track plays.

 

Getting New Applications

Livescribe and other companies offer new applications for your Livescribe smartpen. You can 
download these from the Livescribe Online Store. Just go to www.livescribe.com/store and browse the 
applications available. Some applications are free and others are available for purchase. These 
applications are designed to work like the built-in applications that come with your Livescribe 
smartpen. Visit the store regularly to check for new updates. 

After you download a new application, you can use Livescribe™ Desktop and add it to any Livescribe 
smartpen registered to your Livescribe account. 

All applications are installed through Livescribe Desktop. Livescribe Desktop installs downloaded 
applications to your smartpen under a new Applications menu. This menu is the first menu item 
underneath the Main Menu and is available after you install your first downloaded application. For 
more information on how to purchase, download, and install applications, refer to the Livescribe 
Desktop User Guide. 
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Getting New Applications
To launch a purchased application on your smartpen: 

1. Double-tap the center of a Nav Plus to get to 
the Main Menu.

 

2. Tap down to scroll to the Applications menu. 

  

3. Tap right to view the first of your purchased 
applications. 

[  

4. Tap down to scroll through other applications 
and locate the one you want to launch.  
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Getting New Applications
5. Tap right to launch the application.

NOTE: You can also launch the application using 
Quick Launch or Launch Line. See 
Launching Applications with a Quick 
Command on page 54 and Launch Line and 
Tap Around on page 67.
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8 Livescribe™ Desktop and 
Livescribe™ Online
About Livescribe™ Desktop

Livescribe™ Desktop is software you install on your computer to store and access the Livescribe 
smartpen content. With Livescribe Desktop you can search and review your written notes and listen to 
your recorded audio. You can also export your notes and recorded audio and save them as Pencasts 
and save them as files on your computer to share with others. Livescribe Desktop also installs 
smartpen updates and applications to your smartpen. To learn more about Livescribe Desktop, see the 
Livescribe™ Desktop User Guide available under the Livescribe Desktop Help menu.

About Livescribe™ Online

Livescribe™ Online is your connection to your personal web space and profile at livescribe.com. You 
can upload copies of your notes and recorded audio as Pencasts to Livescribe Online to share with 
others. You can also use Livescribe Online to manage your personal myLivescribe space and access 
the Livescribe Online Store. From the store, you can purchase Livescribe smartpens, notebooks, and 
accessories. You can also purchase additional applications for your Livescribe smartpen. See Getting 
New Applications on page 103 for more information. To learn more about Livescribe Online, including 
how to purchase applications, see the Livescribe™ Desktop User Guide.
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9 Working with Dot Paper Products
Livescribe prints notebooks, journals, flip notepads, and other Livescribe™ dot paper products for your 
Livescribe smartpen. There is nothing special about the composition of the paper used for Livescribe™ 
dot paper products. However, each page of Livescribe™ dot paper is printed with thousands of nearly-
invisible microdots arranged in a special pattern. Your Livescribe smartpen reads these dots to 
determine which page you are using and where on that page you are tapping or writing. With this 
information, your smartpen can capture your notes, link audio to them, and perform other paper-based 
operations. 

Livescribe™ dot paper products sometimes re-use dot pattern. As a general rule, do not use 
Livescribe™ dot paper products with the same dot pattern at the same time. This prevents a potential 
problem that can happen when viewing your notebooks in Livescribe™ Desktop: when you write in two 
notebooks with the same pattern, your notes from the second notebook will be superimposed on your 
notes from the first notebook when you view them in Livescribe™ Desktop. 

Because Livescribe™ dot paper Products are important to working with your Livescribe smartpen, you 
should learn to manage and archive them. 

Guidelines for Managing Paper Products

Understanding how your Livescribe smartpen interacts with Livescribe™ dot paper can be challenging. 
Fortunately, you do not need to know how it all works. All you need to do is follow these guidelines:

• Before using the new paper product, tap on the Notebook Status Label. If it says you are already 
using a notebook with the same number, be sure to archive your old notebooks on Livescribe™ 
Desktop first. See Checking Paper Product Usage on page 108. 

• When purchasing Livescribe™ dot paper, buy notebooks or journals that have different numbers 
than the ones you are currently using. To learn about Livescribe™ dot paper numbering, see About 
Livescribe™ Dot Paper Naming on page 108. 
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Checking Paper Product Usage
• To learn about using packs of notebooks, see Using Packs of Notebooks and Journals on 
page 109. 

• If you own notebooks that have the same naming and numbering, use them sequentially. See Using 
Notebooks with Same Names and Numbers on page 109. 

• Archive your notebooks and journals after you have finished with them. For more information, see 
Archiving Paper Products on page 110.

Checking Paper Product Usage

Each Livescribe™ dot paper product has a Notebook Status Label. Using the Notebook Status Label is 
the best way to tell if you are currently using a Livescribe™ dot paper product that has the same dot 
pattern. 

 

To use the Notebook Status Label:

1. When you open a new Livescribe™ dot paper product, tap on its Notebook Status Label with your 
Livescribe smartpen.

2. Your Livescribe smartpen display will show whether you are using another Livescribe™ dot paper 
product with the same dot pattern. If you are, archive the older Livescribe™ dot paper product 
before using the new one. See Archiving Paper Products on page 110. 

3. In some cases, your Livescribe smartpen will need to be updated to use a new paper product. If this 
occurs, your smartpen display will indicate this when you tap the Notebook Status Label. To use the 
new paper product, run Livescribe™ Desktop, dock your Livescribe smartpen, and accept the 
option to update your smartpen firmware and software.

About Livescribe™ Dot Paper Naming

Livescribe identifies a Livescribe™ dot paper product by a group (such as Lined Notebook) and a 
number (from 1 to 8). Any two Livescribe™ dot paper products labeled with the same group and 
number have the same dot pattern.
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Using Notebooks with Same Names and Numbers
Each Livescribe™ dot paper product belongs to a group based on its format (lined, unlined, grid...) and 
form factor (notebook, journal, notepad …). 

Livescribe further identifies each paper product with a number.  Within a group, paper products labeled 
with the same number have the same dot pattern. Paper products labeled with different numbers have 
different dot patterns. Currently, numbers in a group run from 1 to 8.

Using Notebooks with Same Names and Numbers

If you own two Livescribe™ dot paper products with the same Group and Number (such as two Lined 
Notebook 2 paper products), you should follow these guidelines:

• Use only one of the Livescribe™ dot paper products at a time. Do not use the two paper products at 
the same time. 

• Before starting on the second paper product, archive the first one with Livescribe™ Desktop.

For example, do not use two Lined Notebook 1 paper products at the same time. Instead, use another 
lined notebook with a different Number, such as a Lined Notebook 2 or Lined Notebook 3. 

If you have used all the Numbers in the Lined Notebook group, you may wish to start a second, 
unused Lined Notebook 1. To do so, archive the first Lined Notebook 1. Then you can use your 
Livescribe smartpen on the second Lined Notebook 1.

Using Packs of Notebooks and Journals

A pack of notebooks or journals contains Livescribe™ dot paper products of the same group.  For 
example, Lined Notebooks come in packs of four (Notebooks 1-4 and 5-8). If you want to buy two or 
more packs of Lined Notebooks, verify that the Numbers on the Notebook covers are different. For 
example, buy and use Notebooks 1-4 and Notebooks 5-8 before buying another pack of 1-4 or 5-8. 

If you have purchased two packs with the same numbering, the packs will have the same dot pattern. 
In this case, you should proceed as follows:

• Use all the Livescribe™ dot paper products in the first pack before starting on the second pack. 

• When you have finished with the first pack, archive each Notebook from the first pack and then start 
using the second pack.
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Archiving Paper Products
Archiving Paper Products

When you have finished using a Livescribe™ dot paper product, you should archive it in Livescribe™ 
Desktop. To learn how to archive a Livescribe™ dot paper product, see the Livescribe™ Desktop User 
Guide. Archiving a Livescribe™ dot paper product does the following:

• Frees up storage space on your Livescribe smartpen

• Enables you to use another Livescribe™ dot paper product that has the same dot pattern as the 
one you archived. Livescribe™ dot paper products with the same dot pattern have the same name.

• Moves your notes and audio for a Livescribe™ dot paper product into an Archived Notebooks folder 
in the Library Pane of Livescribe™ Desktop. Your notes and audio remain interactive in 
Livescribe™ Desktop, just like non-archived Livescribe™ dot paper products. 

• Deletes your notes (ink data) and audio from your Livescribe smartpen. Because of this, your 
Livescribe smartpen will no longer interact with the physical Livescribe™ dot paper product that you 
archived. That is, when you tap the notes in your archived physical notebook, they will not play back 
any audio. 

IMPORTANT: 
• Do not archive a notebook unless you are finished using the physical notebook and are ready to set 

it aside. 
• Once you have archived a notebook, do not go back to its physical notebook and start writing on it 

again, unless you have unused pages and want to treat them as a part of a new notebook. For 
example, you could archive a notebook that is partially completed, and then use the remaining 
pages as a second notebook. 

• If you are using multiple computers to manage your smartpen data, be sure to archive your 
notebooks on all of these computers.
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10 Regulatory Information
US FCC Statement

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

• The use of shielded I/O cables is required when connecting this equipment to any and all optional 
peripheral or host devices. Failure to do so may violate FCC rules. Shielded I/O cables are 
available for the Livescribe smartpen from Livescribe.

Changes or modifications not covered in this Guide must be approved in writing by the manufacturer’s 
Regulatory Engineering Department. Changes or modifications made without written approval may 
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void the user’s authority to operate this equipment. 

Responsible Party:

Livescribe Inc

7677 Oakport Street, 12th Floor

Oakland, CA  94621

United States of America

(510) 777-0771
 

Canadian, Industrie Canada ICES-003 Statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le matériel 
brouilleur du Canada.

CE Declaration of Conformity

Manufacturer and EU Responsible Party: 

Livescribe Inc.

7677 Oakport Street, 12th Floor

Oakland, CA  94621

United States of America

(510) 777-0771

This product was tested by Livescribe Inc. and found to comply with all the requirements of the EMC 
Directive 2004/108/EC and of the LVD Directive 2006/95/EC.
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This device conforms to the following standards:

EN 55022 (1998); CISPR 22  as amended, (Class B Radiated and Conducted Emissions)

EN 55024 (1998); CISPR 24 as amended, (Emissions and Immunity, as applicable)

EN60950-1 and IEC 60950-1, Information technology equipment. Safety.

ROHS Compliance Statement

Livescribe has determined that this product complies with the requirements of the Restriction of 
Hazardous Substances (ROHS) directive 2002/95/EC and its amendments. For additional information, 
contact Livescribe at the address above.

UL

Use only with Listed ITE.

This device conforms to the following standards: UL60950-1, First Edition

Battery Warning

WARNING: DO NOT MUTILATE, PUNCTURE, OR DISPOSE OF BATTERIES IN FIRE. THE BATTERIES CAN BURST 
OR EXPLODE, RELEASING HAZARDOUS CHEMICALS. DISCARD USED BATTERIES ACCORDING TO 
THE MANUFACTURER’S INSTRUCTIONS AND IN ACCORDANCE WITH YOUR LOCAL REGULATIONS.

VARNING: EKSPLOSIONSFARA VID FELAKTIGT BATTERIBYTE. ANVÄND SAMMA BATTERITYP ELLER EN 
EKVIVALENT TYP SOM. REKOMMENDERAS AV APPARATTILLVERKAREN. KASSERA ANVÄNT BATTERI ENLIGT 
FABRIKANTENS INSTRUKTION.

ADVARSEL! LITHIUMBATTERI—EKSPLOSIONSFARE VED FEJLAGTIG HÅNDTERING. UDSKIFTNING MÅ KUN SKE 
MED BATTERI AF SAME FABRIKAT OG TYPE. LEVÉR DET BRUGTE BATTERI TILBAGE TILLEVERANDØREN.

VAROITUS: PARISTO VOI RÄJÄHTÄÄ, JOS SE ON VIRHEELLISESTI ASENNETTU. VAIHDA PARISTO AINOASTAAN 
VALMISTAJAN SUOSITTELEMAAN TYYPPIIN. HÄVITÄ KÄYTETTY PARISTO VALMISTAJAN OHJEIDEN MUKAISESTI.
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ADVARSEL: EKSPLOSJONSFARE VED FEILAKTIG SKIFTE AV BATTERI. BENYTT SAMME BATTERITYPE ELLER 
EN TILSVARENDE TYPE ANBEFAIT AV APPARATFABRIKANTEN. BRUKTE BATTERIER KASSERES I HENHOLD TIL 
FABRIKANTENS INSTRUKSJONER.

WAARSCHUWING! BIJ DIT PRODUKT ZIJN BATTERIJEN GELEVERD. WANNEER DEZE LEEG ZIJN, MOET U ZE 
NIET WEGGOOIEN MAAR INLEVEREN ALS KCA.

Static Electricity, ESD, and the Livescribe™ Smartpen

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the device, so 
you should take steps to avoid such an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of excess electrons on the surface of a 
material. To most people, static electricity and ESD are nothing more than annoyances. For example, 
after walking over a carpet while scuffing your feet, building up electrons on your body, you may get a 
static shock—the discharge event—when you touch a metal doorknob. This little shock discharges the 
built-up static electricity.

ESD-Susceptible Equipment

Even a small amount of ESD can harm circuitry, so when working with electronic devices, take 
measures to help protect your electronic devices, including your Livescribe smartpen, from ESD harm. 
While Livescribe has built protections against ESD into its products, ESD unfortunately exists and, 
unless neutralized, could build up to levels that could harm your equipment. Any electronic device that 
contains an external entry point for plugging in anything from cables to docking stations is susceptible 
to entry of ESD. Devices that you carry with you, such as your handheld, build up ESD in a unique way 
because the static electricity that may have built up on your body is automatically passed to the device. 
Then, when the device is connected to another device such as a docking station, a discharge event 
can occur.

Precautions against ESD

Make sure to discharge any built-up static electricity from yourself and your electronic devices before 
touching an electronic device or connecting one device to another. The recommendation from 
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Livescribe is that you take this precaution before connecting your smartpen to your computer, placing 
your smartpen in a cradle, or connecting it to any other device. You can do this in many ways, including 
the following:

• Ground yourself when you are holding your mobile device by simultaneously touching a metal 
surface that is at earth ground. For example, if your computer has a metal case and is plugged into 
a standard three prong grounded outlet, touching the case should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD Occurrences

Conditions that can contribute to the buildup of static electricity in the environment include the 
following:

• Low relative humidity.

• Material type. (The type of material gathering the charge. For example, synthetics are more prone 
to static buildup than natural fibers like cotton.)

• The rapidity with which you touch, connect, or disconnect electronic devices.

• While you should always take appropriate precautions to discharge static electricity, if you are in an 
environment where you notice ESD events, you may want to take extra precautions to protect your 
electronic equipment against ESD.

Warranty Information

LIMITED WARRANTY. Livescribe warrants the Livescribe smartpen to be free from defects in 
materials and workmanship under normal use for a period of one year from the date of original direct or 
retail purchase.  This warranty is void if the product has been damaged by accident or unreasonable 
use, immersion in water, neglect, abuse, improper maintenance, our other causes not arising out of 
defects in workmanship or materials of the product. All warranty claims are subject to: (1) you notifying 
Livescribe of the warranty claim within the warranty period, (2) Livescribe verifying the existence of a 
defect in the product and (3) receipt of valid proof of your purchase and the date of your purchase. 
Your exclusive remedy shall be, at Livescribe's option, to have it repaired or receive a replacement 
Livescribe smartpen. Before returning the Livescribe smartpen, please contact the Livescribe 
Customer Service Department for instructions.  
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In the event that a product under warranty is repaired or replaced, the replacement will be covered 
under the original warranty or for 30 days, whichever is longer.  Repair or replacement is your 
exclusive remedy, and Livescribe’s exclusive liability, under this warranty.  

THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY WARRANTY MADE TO YOU AND 
IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) CREATED BY ANY 
DOCUMENTATION OR PACKAGING. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS.

DISCLAIMER OF WARRANTIES. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF 
THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN AND OTHER PRODUCTS 
AND SERVICES IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY 
QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED 
WARRANTY SET FORTH ABOVE AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW, THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN, PRODUCTS AND 
SERVICES ARE PROVIDED “AS IS”, WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY 
KIND, AND LIVESCRIBE AND LIVESCRIBE'S LICENSORS (COLLECTIVELY REFERRED TO AS 
“LIVESCRIBE”) HEREBY DISCLAIM ALL OTHER WARRANTIES AND REPRESENTATIONS, 
EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A 
PARTICULAR PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT 
OF THIRD PARTY RIGHTS. LIVESCRIBE DOES NOT WARRANT AGAINST INTERFERENCE WITH 
YOUR ENJOYMENT OF THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN, 
PRODUCTS OR SERVICES, THAT THE FUNCTIONS CONTAINED IN THE LIVESCRIBE DESKTOP 
SOFTWARE, LIVESCRIBE SMARTPEN, PRODUCTS OR SERVICES WILL MEET YOUR 
REQUIREMENTS, THAT THE OPERATION OF THE LIVESCRIBE DESKTOP SOFTWARE, 
LIVESCRIBE SMARTPEN OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, OR 
THAT DEFECTS IN THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN OR 
SERVICES WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 
BY LIVESCRIBE OR ANY LIVESCRIBE AUTHORIZED REPRESENTATIVE SHALL CREATE A 
WARRANTY. SHOULD THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN, OR 
SERVICES PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. 

LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL 
LIVESCRIBE BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY 
OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE 
OR INABILITY TO USE THE LIVESCRIBE DESKTOP SOFTWARE, LIVESCRIBE SMARTPEN, OR 
SERVICES, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, 
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TORT OR OTHERWISE) AND EVEN IF LIVESCRIBE HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. IN NO EVENT SHALL LIVESCRIBE'S TOTAL LIABILITY TO YOU FOR ALL 
DAMAGES (OTHER THAN AS MAY BE REQUIRED BY APPLICABLE LAW IN CASES INVOLVING 
PERSONAL INJURY) EXCEED THE AMOUNT OF FIFTY DOLLARS ($50.00). THE FOREGOING 
LIMITATIONS WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS ESSENTIAL 
PURPOSE.
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11 Product Safety and Maintenance
WARNING: FAILURE TO FOLLOW THESE SAFETY INSTRUCTIONS COULD RESULT IN FIRE, ELECTRIC SHOCK, OR 
OTHER INJURY OR DAMAGE. 

The Livescribe smartpen may be damaged by improper handling or storage.  Do not drop, throw, bend, 
crush, deform, puncture or open the Livescribe smartpen.  Failure to follow these instructions could 
result in electric shock, fire, personal injury, property damage or damage to your smartpen, as well as 
voiding your limited warranty. It is also essential that you take proper care of the Livescribe smartpen 
to ensure its durability.  Here are our guidelines:

• Do not drop your smartpen or allow any other kind of strong impact, which can severely damage it 
or prevent it from working properly.

• Do not place your smartpen in any area where it could be crushed (i.e. back pocket, bottom of 
backpack, etc.)  

• Do not store your smartpen in extreme high or low temperatures. Store it in a cool, dry place.

• Do not expose your smartpen to water or any other liquids. It is not waterproof or water resistant.  
Do not leave it in damp conditions.

• Do not dispose of your smartpen in a fire, as the battery may explode or ignite.

• Only use Livescribe-approved ink cartridges.

• Store your smartpen in a protective case. 

• Use a soft cloth for general cleaning.  

• Transfer your important notes and Paper Replay™ sessions from your smartpen to your Livescribe 
Desktop often so that you have a backup copy on your computer. Also, backup your computer’s 
files regularly.

• Keep your smartpen charged.

IMPORTANT: Do not attempt to charge your smartpen via any other means other than:

• The USB mobile charging cradle provided in the box with your Pulse smartpen or the Pro Charging 
Cradle accessory, or 
Livescribe™ Smartpen User Guide 118



• The included Micro USB cable or any standard Micro USB cable for the Echo smartpen.

WARNING: DO NOT ATTEMPT TO DO ANY REPAIRS YOURSELF.   
DO NOT ATTEMPT TO OPEN THE LIVESCRIBE SMARTPEN, DISASSEMBLE IT, REMOVE THE BATTERY, 
OR ATTEMPT TO REPLACE THE BATTERY YOURSELF. THIS RUNS THE RISK OF ELECTRIC SHOCK, 
FIRE, PERSONAL INJURY, PROPERTY DAMAGE OR DAMAGE TO YOUR SMARTPEN, AS WELL AS 
VOIDING THE LIMITED WARRANTY. THERE ARE NO USER-SERVICEABLE COMPONENTS INSIDE AND 
ANY ATTEMPT TO OPEN YOUR SMARTPEN WILL VOID THE WARRANTY. 
 
DO NOT ATTEMPT TO ACCESS THE BATTERY. THE RECHARGEABLE BATTERY IS NOT ACCESSIBLE 
AND IS NOT INTENDED TO BE REMOVED, REPLACED, OR TOUCHED.  THE BATTERY CONTENTS CAN 
BE HAZARDOUS IF INGESTED.  THE BATTERY TECHNOLOGY IS COMBUSTIBLE AND ONLY CHEMICAL 
FIRE RETARDANTS OR SAND SHOULD BE USED TO EXTINGUISH FLAMES.  DO NOT USE WATER. IF 
THE BATTERY LEAKS, DO NOT ALLOW THE LIQUID TO COME IN CONTACT WITH THE SKIN OR EYES. 
 IF IT DOES COME IN CONTACT WITH SKIN OR EYES USE LARGE AMOUNTS OF WATER TO WASH THE 
AFFECTED AREA AND IMMEDIATELY SEEK MEDICAL ADVICE.

Cleaning Your Livescribe™ Smartpen

If your smartpen appears sluggish or non-responsive when you interact with printed controls, the 
infrared lens at its tip may be dirty. Clean this lens with an alcohol wipe.

Clean the exterior of your smartpen with a clean, soft cloth dampened slightly with water. 

Disposal

Do not dispose of this product in the trash.  As with any product containing batteries, check with your 
local waste or recycling company to determine the correct disposal method and location in your area. 

Hearing Notice

Long-term exposure to the playback of loud recordings, at high volume, may result in permanent 
hearing loss.  When using earbuds or headphones, it is recommended that recordings are listened to 
at moderate volumes.  Set the volume to a safe level.  A rule of thumb is that the recorded audio 
should not be so loud that you cannot hear people speaking to you.
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12 Frequently Asked Questions
Recording Notes and Audio

Can I capture notes without recording audio?

Yes. To capture notes simply turn your smartpen on and begin writing on Livescribe™ dot paper. To 
record audio, tap the record button in your included notebook. 

Can I record audio without Livescribe dot paper?

Yes. Press and hold the smartpen power button until you see the recording timer appear on the 
display. When you are done recording simply turn off the smartpen. To play back the audio, go to the 
smartpen’s Main Menu, select Paper Replay™, and then select Play session. While you are playing 
back the audio, you can write down notes on dot paper and the audio will automatically link to your 
notes. 

Can I add new notes to the audio that I’ve already recorded?

Yes. You can always listen to your recorded audio later and write additional notes. Tap on your original 
notes to start playing back the audio. Then write on dot paper to link your new notes to the existing 
audio.   

How do I change the audio recording quality?

To adjust recording quality, go to the smartpen Main Menu, scroll down to Settings, select Recording 
quality, and then choose High, Medium, or Low. Higher quality recordings will take up more space in 
your smartpen memory. 
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Smartpen Accessories
Smartpen Accessories 

How do I replace my ink cartridge?

Grab the tip of the ink cartridge with your fingers and pull it out. Once the ink cartridge is removed, 
slide in a new one. 

Livescribe Desktop 

How do I organize my notes? 

You can create Custom Notebooks in Livescribe™ Desktop to organize and better manage your 
pages. A Custom Notebook is similar to a music playlist, or a digital photo album, but instead of 
pointing to user-selected songs or pictures, it points (links) to user-selected pages in their source 
notebooks.

On Windows:

1. Choose File > Custom Notebooks > Create. Or, click the Create new Custom Notebook link under 
Custom Notebooks in the Library tab.

2. In the Notebook Name dialog, type in a name for the new notebook. Click OK.

3. Livescribe Desktop creates and opens the new notebook and places it in the Library tab under the 
heading Custom Notebooks. 

4. Drag and drop the page(s) to the Custom Notebook name in the Library Pane. The pages you 
selected appear in the Custom Notebook.

5. You can organize the pages in a Custom Notebook by simply dragging, moving, and dropping them 
into their new order. 

6. You can view information about the source of a page by hovering over it with a mouse cursor. 
Source information includes the smartpen associated with the page, its notebook, and source page 
number.

On Mac:

1. Choose File > Create Custom Notebooks. Livescribe Desktop creates an empty custom notebook 
and places it in the Navigation pane under the heading Custom Notebooks. 
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Livescribe Desktop
2. To add pages to a custom notebook, select one or more pages in Page View and drag and drop 
them onto the custom notebook in the Navigation pane. 

3. To add pages from Audio View, select one or more sessions that have associated pages and drag 
and drop them onto the custom notebook.

4. You can organize the pages in a Custom Notebook by simply dragging, moving, and dropping them 
into their new order. 

What can I share?

Using Livescribe Desktop, you can share pages, Paper Replay audio sessions, or both. Livescribe 
Desktop gives you several export options for this content, including:

• .pencast file: a portable format unique to Livescribe content capable of being imported and used in 
Livescribe Desktop.

• Adobe® Flash® movie (Livescribe Online uploads only)

• Adobe® PDF format

• Standard audio formats

• Standard image formats

How do I share my pencasts as .pencast files?

One way to share pencasts is to upload your smartpen content (audio, pages, or both) to your 
myLivescribe account on Livescribe Online. You can keep it private, share it with others, or share with 
the Livescribe community.

Another way to share pencasts is to export them as .pencast files. A .pencast file is a proprietary file 
format unique to Livescribe content. This kind of file can be imported directly into Livescribe Desktop 
by anyone who has it. 

On Windows:

1. In Pages View, choose one or more pages whose content you want to share. Note: You can also 
export .pencast files from Audio View. In Audio view, choose or play the session you want to share.

2. Click the Share button on the Main Toolbar

3. Using the cascading menus, select the type of data you want to share and how to share it. Your 
options are to share: The entire current notebook associated with your selected page(s).
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Livescribe Desktop
4. The specific page(s) you selected.

5. Using the cascading menus, choose: As Pencast.

6. In the Select Data for Pencast dialog, choose what to share: Pages and Audio, Pages Only, or 
Audio Only.

7. Refine your sharing options: If you are sharing pages, use the checkboxes to select pages 
individually or select all pages.

8. If you are sharing audio only or audio and pages, select one or more audio sessions to export from 
the Select Audio to Share drop down list.

On Mac:

1. In Pages View, choose one or more pages you want to share. Or, in Sessions View, select one or 
more sessions to share. 

2. Click one of the share buttons on the Main Toolbar, or right-click and choose Share. This opens the 
share dialog. Choose a sharing option. 

3. Click the Export Pencast button to export a .pencast file. The .pencast file is a portable format 
unique to Livescribe content. This kind of file can be imported directly into Livescribe Desktop by 
anyone who has it. Only one audio file allowed per .pencast file.Your computer.

4. Use the share dialog to specify what to share. 

5. Give a name to the content you are sharing, and if required, provide log in information.

6. Click Share to share the content.

How can I share pencasts using a MyLivescribe account?

Once you register your smartpen, you can share up to 500MB through your MyLivescribe account. 

Private sharing: All your uploaded pencasts are set to private by default – only accessible to you. You 
can add specific people to your Access List, giving them permission to see your private pencasts, and 
then send them a link to view. The people on your Access List will be required to create a Livescribe 
account to view pencasts. 

Public sharing: Once you make your pencast public, it can be accessed by anyone, even without a 
Livescribe account. You can send the pencast URL, share it on Facebook™, or embed it on a website. 
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How do I share my notes as a PDF?

On Windows:

1. In Livescribe™ Desktop's Pages View, choose one or more pages you want to share.

2. Click the Share button on Main Toolbar. 

3. Using the cascading menus, select the type of data you want to share and how to share it. Your 
options are to share: 
• The entire current notebook associated with your selected page(s).

• The specific page(s) you selected.

4. Using the cascading menus, choose: As PDF...

5. In the Save PDF dialog, type the PDF file name and choose a folder for the file. 

On Mac:

1. Select one or more pages in Pages View.

2. Click the Print button or choose File > Print. The Print dialog opens.

3. In the Print dialog, click the PDF button and select Save as PDF.

4. Click Print.

How do I share my recordings into an audio file?

On Windows:

1. In Livescribe Desktop Audio view, choose the session or sessions you want to share.

2. Click the Share button on Main Toolbar.

3. Using the cascading menus, choose As Audio file.

4. In the Export Session dialog, type the audio file name and choose a folder for the file.

5. Choose the audio file format.

6. Click Save.

On Mac:

1. In Audio view, select the session to export as a file.
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2. Choose File > Export as AAC, or choose the contextual menu item by pressing control-click. The 
Save dialog opens. 

3. Select a destination to save to.

4. Save the session name as it is, or type a new one.

5. Click Save. Your audio file is saved to the specified location and is available for listening on your 
computer or for export.

6. Double-click on the item to play in QuickTime, or drag it into your iTunes library or to your iTunes 
icon to play in iTunes.

How do I get the latest software updates?

Whenever you launch Livescribe Desktop, it will automatically check for updates and notify you if an 
update is available for your smartpen and/or Livescribe Desktop. Make sure to download and install all 
updates, so you’ll always have the latest, greatest features. You can also manually check for updates 
through Livescribe Desktop. Click on the Help menu and select Check for Updates. 

Can I convert my handwriting into text?

Yes. You can buy and download additional software called MyScript® for Livescribe. It works with 
Livescribe Desktop to convert legible handwritten notes into editable text. For more information, go to: 
www.visionobjects.com. 

Can I use my smartpen with more than one computer?

Yes. If you use multiple computers, make sure to connect your smartpen and transfer your data to 
each computer on a regular basis. Make sure you use the same username (email address) and 
password for each copy of Livescribe Desktop you install. Every time you archive a notebook on one 
computer, be sure to archive it on your other computers as well.   

How do I print my own dot paper?

To print your own dot paper, you need to have Livescribe Desktop version 2.0 or later and an Adobe 
PostScript-compatible color laser printer with a print resolution of 600 dpi or greater. 

1. Within Livescribe Desktop, click on Pages so you are viewing your notes. In the menu, select Tools.
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2.  On a Mac®, choose Print Your Own Notebook. If you are using Windows®, choose Printable 
Notepads. 

3. Choose the notepad you would like to print, the printer you want to print to, and click Print 

Can I change the date and time format?

Yes. You can set your smartpen to display the time in 12- or 24-hour format, and the date in any of 
several formats. You can find format options on your smartpen under: Main Menu> Settings> Time 
Format or Main Menu> Settings> Date Format.

Smartpen Shortcuts

Whether you are a beginning, intermediate or advanced user, the following shortcuts will help you get 
the most out of your smartpen. 

Double-tap

When the smartpen asks you for input (like drawing a button, or writing a word for translation), to signal 
you are finished writing, rapidly tap twice in the same spot on dot paper. 

Draw your own Nav Plus

Draw a plus with two lines about an inch long, then double-tap the center quickly. You should see Main 
Menu on the smartpen display. Tap on the Nav Plus to view and select menu items. 

Flick and Scrub (quickly scroll through menu items)

On dot paper, press the tip of your smartpen down for half a second until you hear a short beep. Then, 
without lifting your smartpen tip off the paper, draw a horizontal or vertical line. Your smartpen will 
automatically recognize this line as a flick and scrub control. Retrace the line anytime to scroll through 
menu items or display text. 
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Paper Replay™ Password
Quick Launch (jump to an application and quickly launch it)

Double-tap on the center of the Nav Plus control. Then start writing the first few letters of the 
application name, continuing until you see the name appear on the display. Tap the right arrow of your 
Nav Plus to launch the application. You can later tap on what you wrote to re-launch the application.

Launch Line

Similar to Quick Launch, you can use Launch Line to quickly launch any Open Paper application 
installed on your smartpen. Open Paper applications are applications that do not require pre-printed 
paper controls to function. 

1. Draw a horizontal line on your notebook (starting from right or left) and without removing your 
smartpen tip from the page, immediately double back on the line ending close to where you started. 

2. Immediately write the name of the target application above the line. 

3. To launch the application, tap on the application name you have written. You can later tap on what 
you wrote to re-launch the application. 

You can use the Launch Line tap-around feature to navigate the application. You can tap just above, 
below, left, or right of the application name to perform corresponding functions of the Nav Plus.

Paper Replay™ Password
Keep your recorded Paper Replay™ sessions private. To set up Paper Replay Password protection:

1. Power on your smartpen.

2. Go to the Main Menu by tapping the center of the Nav Plus at the bottom of your Livescribe Dot 
Paper.

3. Tap down to Paper Replay.

4. Tap down to Password protection to set your 4-digit password.

5. Write a 4-digit password on your dot paper notebook. You can disguise your password by using any 
of the following methods:
• Write the numbers in a different order (for example, backwards).

• Write the numbers in various places on the same page.

• After writing and confirming your password, go back and write other numbers over your 
password to disguise it.
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6. After setting your password, your smartpen will prompt you for your password each time you try to 
play back a session. Once you turn off password protection, all previously set passwords are 
permanently erased.
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13 Glossary
Refer to the list below for Livescribe terms and their definitions.

3-D recording headset. Earphones with embedded microphones that capture multi-directional, far-
field audio and place objects in the sound landscape surrounding you.

active ink. Notes, drawings, or other markings made by a Livescribe smartpen on Livescribe™ dot 
paper that are associated to recorded audio. By default, active ink is displayed as green in 
Livescribe™ Desktop. See inactive ink.

archiving. The process of moving your notes and audio for a Livescribe™ dot paper product into an 
Archived Notebooks folder in the Navigation Pane. This process also deletes your notes (ink data) and 
audio from the Livescribe smartpen. Because of this, the Livescribe smartpen will no longer interact 
with the physical Livescribe™ dot paper product that you archived. 

audio. Sound of any kind that is captured by the Livescribe smartpen microphone.

Audio (or Sessions) view. Sessions presented as a list of files with details about each.

browsing. Paging through a notebook’s pages.

docking. Connecting a Livescribe smartpen to a personal computer by inserting the smartpen into its 
charging cradle (for Pulse™ smartpens) or Micro-USB cable (for Echo™ smartpens). 

downloading. Receiving data from a remote location.

Echo™ smartpen. A model of smartpen manufactured by Livescribe Inc.

firmware. Software that manages the internal operations of a smartpen.

flash storage. Non-volatile storage of computer files, not dependent on electric charge. Sometimes 
referred to as memory. 
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Flick and Scrub. Flick and Scrub is a feature that enables fast scrolling through menu items and other 
displayed text on the Livescribe smartpen. This feature is useful when text presented by an application 
is longer than the display can show horizontally or when multiple menus, options, or items are 
available vertically.

inactive ink. Notes, drawings, or other markings made by a Livescribe smartpen on Livescribe™ dot 
paper that are not associated to recorded audio. By default, inactive ink is displayed as black in 
Livescribe™ Desktop. See active ink

ink. The markings of the Livescribe smartpen ballpoint on dot paper. See active ink and inactive ink.

Launch Line. Launch Line is similar to Quick Launch. You can use Launch Line to quickly launch any 
Open Paper application installed on your smartpen. Open Paper applications are applications that do 
not require pre-printed paper controls to function. See tap around.

linking. Associating a Livescribe smartpen to an instance of Livescribe™ Desktop.

Livescribe™ Desktop. The computer component of the Livescribe™ platform. Livescribe™ Desktop 
allows you to transfer, store, search, and replay notes from your computer. You can also upload your 
content to the Web, and manage applications and content on the Livescribe smartpen.

Livescribe™ dot paper. Plain paper printed with a microdot pattern. Invented by Anoto AB, and used 
under license by Livescribe. The microdots are nearly invisible to the human eye. The microdots 
enable the Livescribe smartpen to recognize areas on a page, like a printed record button for Paper 
Replay™, and associate handwritten notes with recorded audio.

Livescribe™ Online. Livescribe Web community. Livescribe smartpen owners have free membership 
in Livescribe Online, where members can store up to 500 MB of their sessions. In addition, members 
can share sessions with others and participate in user forums.

microdot. The basic unit of Livescribe’s dot paper: a small, light-gray circular marking that is arranged 
with others like it into millions of patterns. These are printed on Livescribe paper products for use with 
the Livescribe smartpen.

myLivescribe profile. 500 MB of personal space a Livescribe smartpen user is allotted at Livescribe 
Online to store and share notes.

Nav Plus. A pre-printed or hand-drawn plus sign that lets you navigate the Livescribe smartpen 
applications and files.
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notebook. A generic term used in this guide that represents any Livescribe™ dot paper type: Lined 
Notebook, Lined Black Journal, Unlined Black Journal, or Unlined Red journal.

notebook status label. An elliptical paper seal that prevents a Livescribe paper product from being 
opened until detached by the owner. This label defines the product’s status (paper type and series 
number), so you can be aware of potential conflict with paper products of the same status that are 
already in use.

notes. Anything written or drawn on dot paper.

OLED display. 18pixel x 98pixel Organic Light Emitting Diode display screen of the Livescribe 
smartpen.

Pages View. A view in Livescribe™ Desktop that displays notebook pages. Notes are shown as active 
ink if they are associated with audio.

Paper Replay™. An application that associates what you write on paper to audio you record. 

Paper Replay Password.  Paper Replay Password sets a password for your Paper Replay sessions. 
Setting a password can prevent others from listening to your recorded audio on your smartpen. 

PDF. A graphic file format that is used to export writings and drawings saved in Livescribe™ Desktop. 
PDF files can be viewed on or printed from any computer with Adobe Acrobat Reader® installed.

pencast. Pencasting is a general term for exporting smartpen content. Pencasting and is how you 
share your smartpen content with others.You can pencast smartpen content to your computer or to 
Livescribe Online. 

.pencast. A proprietary file format of Livescribe Inc. that stores smartpen content (pages, audio, or 
both). These files can be exported and imported by Livescribe Desktop to allow sharing of smartpen 
content. 

preferences. Settings of Livescribe™ Desktop that conform to your way of working.

Pulse™ smartpen. A model of smartpen manufactured by Livescribe Inc.

quick commands. A series of commands you can write on dotted paper to quickly learn the current 
status of the Livescribe smartpen.
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session. A single, complete audio recording that begins with the Record command and ends with the 
Stop command on the Livescribe smartpen. A session always contains audio and optionally can 
contain associated written notes (pages). 

Sessions (or Audio) view. Sessions presented in Livescribe™ Desktop as a list of files with details 
about each.

Single-Page View (or mode). A view or mode in Livescribe™ Desktop in which a single page is 
displayed at a time.

tap around. Tap around is a feature of Launch Line that is an alternate to using the Nav Plus to 
navigate menus of an application.

thumbnail. A small representation of a page.

Thumbnail View (or mode). A view or mode in Livescribe™ Desktop that shows thumbnail 
representations of pages.

transfer. Copying data from a Livescribe smartpen to a computer using Livescribe™ Desktop. (In this 
context, the sessions remain on the smartpen.)

updating. Installing a new version of software or firmware via Livescribe™ Desktop to your computer 
or smartpen.

uploading. Sending data to a remote location, such as the web.

USB. Universal Serial Bus, a standard for wired connection between personal computers and 
peripheral devices like printers and the Livescribe smartpen. 

USB mobile charging cradle. A cradle that charges and connects a Livescribe smartpen to your 
computer.

zooming. The process or magnifying or reducing pages in Livescribe™ Desktop.
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14 Getting Help
Livescribe Online Support

On the Livescribe Support page you will find several ways to get answers to any questions you might 
have about your smartpen or other Livescribe™ products.

To open the Livescribe Support page:

• From a web browser, go to www.livescribe.com/support, or

• Within Livescribe™ Desktop, go to Livescribe Online and locate the Support tab.
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Contacting Customer Service
User Guides and Release Notes

You can download the latest user guides from the support page. You can also view release notes for all 
Livescribe products: www.livescribe.com/releasenotes.

Knowledge Base (KB)

Browse our knowledge base to find many of the answers to your questions. Livescribe updates the 
knowledge base frequently, so check it each time you need help.

Forum

Other Livescribe smartpen users may have found an answer to your question. Check the forums to 
post a question or browse similar questions and find responses that may help you.

Contacting Customer Service

If you cannot find the answers to your questions using the Support page, please contact Customer 
Service directly. You can reach Customer Service by:

• Filling out the Livescribe Customer Service Response form on the Support page with any issues, 
comments, or recommendations.

• Emailing Customer Service at: CS@livescribe.com

• Phoning Customer Service at: 
US: 1–877–727–4239 (1-877-SCRIBE9) or 1-510–567–4150
US K–12 Education: 1–800–297–3071
UK: 44–870–4791828
Australia: 61–2–8014–9242 

Saving Data for Customer Service
IMPORTANT: If you are experiencing problems with a Livescribe™ Desktop product, you should gather 

data from your installation for Customer Service. 
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Windows:

1. In Livescribe™ Desktop, go to Help > Save Customer Service Data.

2. Save the data to your computer so you can send it to Customer Service if requested. 

Mac OS X:

1. Hold the keyboard control key down and in Livescribe™ Desktop, go to Tools > Customer 
Support > Debug Logs.

2. Save the data to your computer so you can send it to Customer Service if requested. 

Returning Livescribe Products

If you need to return the Livescribe smartpen or other Livescribe product, follow the instructions below.

Items Purchased Directly from Livescribe

Items purchased directly from Livescribe will have the following return timeframe to qualify for a refund. 
Items returned after this timeframe will not be accepted or credited:

• Hardware: 30 days.

• Accessories: 30 days

Livescribe will refund the full amount paid minus shipping on any item(s) returned within the allowable 
time. The customer must contact Customer Service for a Returned Material Authorization (RMA) 
number and is responsible for the original shipping and the return shipping fees. 

A returned item must be returned in like-new condition with all the original components and packaging. 
Credits are issued once the item(s) have been received and verified.

Items Purchased from a Third Party

If you discover what you believe is a software or product defect for any third-party item, please contact 
the manufacturer of such third-party item directly for information regarding that manufacturer's 
warranty. Products sold through the Livescribe website that do not bear the Livescribe brand name are 
serviced and supported exclusively by their manufacturers in accordance with the terms and 
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conditions packaged with the products. Third-party software or products are not covered by 
Livescribe’s Limited Warranty.
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